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General Information

MindFrame 1.1 for Windows is a freeware application Copyrighted by Autobahn Systems, Inc. 1993, 
1994. Permission for distribution is hereby granted, provided that this release is distributed intact, 
including this copyright notice and the version information above. This application is useful in the following
areas:

User Analysis
Task Modeling
Object Modeling
System-Level Design
Metaphor Modeling
Life Form Modeling
Neural Modeling
Ecological Modeling
Universe Modeling
Bible Study

If you enjoyed using this application, please share with others by redistributing it without cost. Thanks be 
to our Lord who opened our minds to realize many applications for this program. We could not have 
completed this application without the abundant grace of our Lord. If you would like to make a donation, 
please send it to the following address:

International Assembly of the True Jesus Church
Attn: Africa Mission
11236 Dale Street
Garden Grove, CA 92641, USA

This application was developed originally to support a software development approach for graphical user 
interface applications presented in the following book:

Title: Object-Oriented GUI Application Development
Author: Geoff Lee
Date: 1993
ISBN: 0-13-363086-2
Publisher: Prentice Hall, Englewood Cliffs, New Jersey 07632



Classes / Aggregations Window

Commands
File menu
Edit menu
View menu
Window menu
Help menu

Shortcuts

Toolbar:

Description
In an object model, there are classes and relationships among these classes. There are two hierarchical 
relationships among classes, namely, the inheritance (superclass / subclass) relationship and the 
aggregation (whole / part) relationship. Classes / Aggregations window allow a user to define classes 
and the hierarchical relationships among them.

1. Enter new class:
A new class is first entered into the Class Name text field at the top center, along with its description 
entered into the Description multi-line text field at the center, and then the New Class command in 
the Edit menu is selected. The entered class appears as a new item in the Classes /Aggregations 
class list at the bottom center. You can also enter the description of a class before you select the New
Class command.

2. Define class hierarchies:
The inheritance relationship (IS-A relationship) and aggregation relationship (PART-OF relationship) 
are defined in this window. A user first double-click an item in the Classes /Aggregations class list at 
the bottom center to select a class as the active class to be displayed in the Object Name text field, 
and then click on a radio item in the Defining Hierarchy group box at the upper left corner to select 
the type of hierarchical relationship you want to define. Now you can single-click on an item in the 
Classes /Aggregations class list at the bottom center, and then select the Define Hierarchy 
command in the Edit menu. The selected class now appears as a new item in one of the class 
hierarchy lists (i.e., Superclasses, Subclasses, Parent Aggregations, or Child Classes list) 
depending on the current selection in the Defining Hierarchy group box.



3. Commit changes in class description and/or class hierarchies:
After a new class is entered into the Classes /Aggregations class list, you can double-click the item 
to select it as the active class to be displayed in the Class Name text field. Then you can change the 
description of this class in the Description text field, or change the hierarchical relationships of it by 
inserting or deleting classes from the lists of hierarchical relationships. Once you are done with 
modifying it, you can select the Commit Changes command in the Edit menu.

4. Delete a class from one of the class lists:
You can delete a class already in the Classes /Aggregations class list, or any of the class 
hierarchies lists. First, you click on the item in a list that you want to delete, and then select the Delete
command in the Edit menu.
** Please note that if you are deleting a class in the Classes /Aggregations class list, all the 
attendant information (e.g., class hierarchies, objects) will be removed as well. Any reference to this 
class is also removed from other document windows.



Class Definitions Window

Commands
File menu
Edit menu
View menu
Window menu
Help menu

Shortcuts

Toolbar:

Description
A class has attributes that characterize it, and operations that get/set the attributes. Each attribute also 
has the facets of data type, domain (i.e., possible values), default values, multiplicity (i.e., single- or multi-
valued). Class Definitions document window allow a user to define the attributes and operations of a 
class, and the attribute facets.

1. To select an active class:
Select an item from the Class Name drop-down list at the top.

2. To enter attributes:
In the Attribute Name / Description grid contro near the top, select a cell to receive keyboard input 
by clicking the mouse button or using the TAB key and/or the up/down arrow keys on your keyboard. 
You can enter the attribute name and its description in the cells. If you have more than 5 attributes for 
a class, you can use the New Attribute command in the Edit menu to get a new row of cells.

3. To enter attribute facets:
The Attribute Facets group box in the middle of the document window allow user to enter attribute 
facets of the active attribute (i.e., the cell with the flashing keyboard cursor). The group box contains 
four facets controls:

the Data Type drop-down combo box: You can enter a new data type or select one already in the 
drop-down list.
the Domain drop-down combo box: You can enter a new attribute domain (i.e., possible values) 
or select on previously entered in the drop-down list.
the Default Value drop-down combo box: You can enter a new default value for the attribute or 
select one value from the drop-down list.
the Multiplicity radio buttons: You can define the attribute to be single-valued or multiple-valued.

4. To enter operations:
In the Operation Name / Description grid contro at the bottom, select a cell to receive keyboard 
input by clicking the mouse button or using the TAB key and/or the up/down arrow keys on your 
keyboard. You can enter the operation name and its description in the cells. If you have more than 5 
operations for a class, you can use the New Operation command in the Edit menu to get a new row of
cells.

5. To commit changes:
If you made changes to the attributes, operations, and attribute facets of an active class, you can 
commit these changes by selecting the Commit Changes command in the Edit menu.

6. Delete attributes or operations from the Attribute/ Operation grid controls:
You can delete attributes or operations already in the Attribute Name / Description or Operation 
Name / Description Classes grid control by first selecting the rows containing them and then using 
the Delete command in the Edit menu.





Class Relations Window

File menu
Edit menu
View menu
Window menu
Help menu

Shortcuts

Toolbar:

Description
In addition to the hierarchical relationships in the Classes /Aggregations document window, there are 
dynamic and other non-hierarchical relationships among classes. A relationship of this kind may have a 
source class/operation and a destionation class/operation. Class Relations document window allow a 
user to define this type of relationships.

1. Enter new relationship:
A new relationship is first entered into the Relation Name text field at the upper left corner of this 
document window, along with its description entered into the Description multi-line text field below, 
and then the New Relation command in the Edit menu is selected. The entered relation appears as a 
new item in the Relations list at the bottom left. You can also enter the description of a relation before
you select the command.

2. Commit changes in the description and source/destination class and opeation of a relation:
After a new class is entered into the Relations list, you can double-click the item to select it as the 
active relation to be displayed in the Relation Name text field. Then you can change the description 
of this relation in the Description text field, or change the source/destination class and operation. 
Once you are done with modifying it, you can select the Commit Changes command in the Edit menu.

3. Delete a relation:
You can delete a relation already in the Relations list. First, you click on the item in the list that you 
want to delete, and then select the Delete command in the Edit menu.
** Please note that if you are deleting a relation in the Relations list, all the attendant information 
(e.g., source class and operation, destination class and operation, and object links of this relation) will
be removed as well. Any reference to this relation is also removed from the Object Links document 
window.



Objects / Aggregates Window

File menu
Edit menu
View menu
Window menu
Help menu

Shortcuts

Toolbar:

Description
Each class defined in the Classes /Aggregations document window has its object instances. The 
instance of an aggregation class is called an aggregate in our definition. Objects/aggregates of a 
class/aggregation are defined in the Objects / Aggregates document window. Objects and aggregates 
also have Whole/Part links (i.e., instances of a relationship) among them. The Whole/Part links are also 
defined in this document window.

1. Enter new object/aggregate:
A new object/aggregate is first entered into the Object Name text field at the upper left corner of this 
document window, along with its class selected from the Class Name drop-down list at the top right. 
Then the New Object command in the Edit menu is selected. The entered object/aggregate appears 
as a new item in the Objects/Aggregates list at the bottom left.

2. Define the Whole/Part link of an object/aggregate:
The Whole/Part link of an object/aggregate is defined in this window. A user first double-click an item 
in the Objects /Aggregates list at the bottom left to select an object as the active object to be 
displayed in the Object Name text field. Now you can single-click on an item in the Objects 
/Aggregates list to select it, and then select the Define Child command in the Edit menu. The 
selected object now appears as a new item in the Child Objects list at the bottom right.

3. Commit changes in the class of an object and its Whole/Part relationship:
After a new object is entered into the Objects/Aggregates list, you can double-click the item to select
it as the active object to be displayed in the Object Name text field. Then you can change the class of
this object in the Class Name drop-down list, or change the Whole/Part link by selecting a new parent
aggregate from the Parent Aggregate drop-down list. Once you are done with modifying it, you can 
select the Commit Changes command in the Edit menu.

4. Delete an object:
You can delete an object already in the Objects/Aggregates list. First, you click on the item in the list
that you want to delete, and then select the Delete command in the Edit menu.
** Please note that if you are deleting an object in the Objects/Aggregates list, all the attendant 
information (e.g., class name, parent aggregate, and child objects) will be removed as well. Any 
reference to this object is also removed from the Classes/ Aggregations document window and the 
Object Links document window.



Object Links Window

File menu
Edit menu
View menu
Window menu
Help menu

Shortcuts

Toolbar:

Description
A link is an instance of a relationship. In addition to the Whole/Part link in the Objects/Aggregates 
document window, there are dynamic and other non-hierarchical links among objects. A link of this kind 
may have a source object and a destionation object. Object/Links document window allow a user to 
define this type of links.

1. Enter new link:
A new link is first entered into the Link Name text field at the upper left corner of this document 
window, along with its relation selected from the Relation Name drop-down list at the top right, and 
then the New Link command in the Edit menu is selected. The entered link appears as a new item in 
the Links list at the bottom left.

2. Commit changes in the relation of a link and its source/destination object:
After a new link is entered into the Links list, you can double-click the item to select it as the active 
link to be displayed in the Link Name text field. Then you can change the relation in the Relation 
Name drop-down list, or change the source/destination object. Once you are done with modifying it, 
you can select the Commit Changes command in the Edit menu.

3. Delete a link:
You can delete a link already in the Links list. First, you click on the item in the list that you want to 
delete, and then select the Delete command in the Edit menu.
** Please note that if you are deleting a link in the Links list, all the attendant information (e.g., 
relation name, source and destination object) will be removed as well. Any reference to this link is 
also removed from the Class Relations document window.



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits MindFrame.



Edit menu commands for the Classes/ Aggregations Window

The Edit menu for the Classes window offers the following commands:

Undo Undo previous text edit action of the active edit control
New Class Add a new class.into the object model
Define Hierarchy Specify the class inheritance hierarchy by defining superclasses or 

subclasses. Specify the aggregation hierarchy by defining parent 
aggregations or children classes.

Commit Changes Commit all changes made to the active class.
Delete Delete the selected class from the main list of classes or the lists 

defining class hierarchies.
Cut Cut the currently selected text of the active edit control
Copy Copy into the clipboard the currently selected text of the active edit 

control
Paste Paste the text in the clipboard to the active edit control
Clear All Clear the currently selected text of the active edit control



Edit menu commands for the Class Definitions Window

The Edit menu for the Class-Definitions window offers the following commands:

Undo Undo previous text edit action of the active edit control
New Attribute Add a new row of attribute field for the active class
New Operation Add a new row of operation field for the active class.
Commit Changes Commit all changes made to the attributes, operations, and 

attribute facets of the active class.
Delete Delete the selected rows of attributes or operations from the active 

class.
Cut Cut the currently selected text of the active edit control
Copy Copy into the clipboard the currently selected text of the active edit 

control
Paste Paste the text in the clipboard to the active edit control
Clear All Clear the currently selected text of the active edit control



Edit menu commands for the Class Relations Window

The Edit menu for the Relations offers the following commands:

Undo Undo previous text edit action of the active edit control
New Relation Add a new relation between two existing classes. Operations can 

also be selected from the source class and the destination class 
respectively.

Commit Changes Commit all changes made to the active relation, including the 
source class, destination class, and their respective operation.

Delete Delete the selected relation from the main list of relations.
Cut Cut the currently selected text of the active edit control
Copy Copy into the clipboard the currently selected text of the active edit 

control
Paste Paste the text in the clipboard to the active edit control
Clear All Clear the currently selected text of the active edit control



Edit menu commands for the Objects/ Aggregates Window

The Edit menu for the Objects window offers the following commands:

Undo Undo previous text edit action of the active edit control
New Object Add a new object.instance of an existing relation.
Define Child Insert the selected item in the object list as a child object of the 

active aggregate
Commit Changes Commit changes made to the active link, including the object class,

the parent aggrgate, and the childrent objects.
Delete Delete the selected object from the main list of objects or the list of 

children objects.
Cut Cut the currently selected text of the active edit control
Copy Copy into the clipboard the currently selected text of the active edit 

control
Paste Paste the text in the clipboard to the active edit control
Clear All Clear the currently selected text of the active edit control



Edit menu commands for the Object Links Window

The Edit menu for the Links window offers the following commands:

Undo Undo previous text edit action of the active edit control
New Link Add a new link instance.into the object model
Commit Changes Commit changes made to the active link, including the relation, the 

source object, and the destination object.
Delete Delete the selected link from the main list of links.
Cut Cut the currently selected text of the active edit control
Copy Copy into the clipboard the currently selected text of the active edit 

control
Paste Paste the text in the clipboard to the active edit control
Clear All Clear the currently selected text of the active edit control



View menu commands

The View menu offers the following commands:

Classes Select the Classes document window to be the active window
Relations Select the Relations document window to be the active window
Definitions Select the Class-Definitions document window to be the active 

window
Objects Select the Objects document window to be the active window
Links Select the Links document window to be the active window
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in MindFrame.    Select the type of new file you want to 
create in the File New dialog box.    << Remove previous sentence if your application supports only one 
document type. >>

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

<< Delete this help topic if your application supports only one document type. >>

Specify the type of document you wish to create:
<< List your application's document types here >>



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>

Drives
Select the drive in which MindFrame stores the file that you want to open. 

Directories
Select the directory in which MindFrame stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    MindFrame suggests that you 
save changes to your document before you close it.    If you close a document without saving, you lose all 
changes made since the last time you saved it.    Before closing an untitled document, MindFrame 
displays the Save As dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, MindFrame displays the Save As dialog box so you can name your document. 
If you want to change the name and directory of an existing document before you save it, choose the 
Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    MindFrame displays the Save As dialog box 
so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    MindFrame adds the extension you specify in
the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application chooses via the 
OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your MindFrame session.    You can also use the Close command on the 
application Control menu.    MindFrame prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the command changes, 
depending on what the last action was.    The Undo command changes to Can't Undo on the menu if you 
cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



New Class command (Edit menu for the Classes/ Aggregations Window)

Use this command to insert a new class into the class list. A class name must have been entered in the 
Class Name edit control.

Shortcuts

Toolbar:
Keys: INS



Define Hierarchy command (Edit menu for the Classes/ Aggregations Window)

Use this command to insert the currently selected item in the Classes/Aggregations list into a class 
hierarchy list, either the superclass/subclass or the parent-aggregation/child-class hierarchy, depending 
on the current selection in the Defining Hierarchy group box at the top left corner.

Shortcuts

Toolbar:
Keys: ALT+INS



Commit Changes command (Edit menu for the Classes/ Aggregations Window)

Use this command to commit the changes of a currently selected class displayed in the Class Name text 
field at the top center.

Shortcuts

Toolbar:
Keys: ALT+ENTER



Delete command (Edit menu for the Classes/ Aggregations Window)

Use this command to delete a currently selected class in one of the class lists (i.e., the main, superclass, 
subclass, parent aggregations, or child class listbox).

Shortcuts

Toolbar:
Keys: ALT+DEL



New Attribute command (Edit menu for the Class Definitions Window)

Use this command to insert a new row of cells in the Attribute Name / Description grid control near the 
top.

Shortcuts

Toolbar:
Keys: INS



New Operation command (Edit menu for the Class Definitions Window)

Use this command to insert a new row of cells in the Operation Name / Description grid control at the 
bottom.

Shortcuts

Toolbar:
Keys: ALT+INS



Commit Changes command (Edit menu for the Class Definitions Window)

Use this command to commit the changes of a currently selected class displayed in the Class Name 
drop-down list at the top.

Shortcuts

Toolbar:
Keys: ALT+ENTER



Delete command (Edit menu for the Class Definitions Window)

Use this command to delete a currently selected rows of attributes in the Attribute Name / Description 
grid control or operations in the Operation Name / Description grid control.

Shortcuts

Toolbar:
Keys: ALT+DEL



New Relation command (Edit menu for the Class Relations Window)

Use this command to insert a new relation into the Relations list. A relation name must have been 
entered in the Relation Name text field.

Shortcuts

Toolbar:
Keys: INS



Commit Changes command (Edit menu for the Class Relations Window)

Use this command to commit the changes of a currently selected relation displayed in the Relation Name
text field at the top left.

Shortcuts

Toolbar:
Keys: ALT+ENTER



Delete command (Edit menu for the Class Relations Window)

Use this command to delete a currently selected relation in the Relations list.

Shortcuts

Toolbar:
Keys: ALT+DEL



New Object command (Edit menu for the Objects/ Aggregates Window)

Use this command to insert a new object into the Objects/ Aggregates list. An object name must have 
been entered in the Object Name edit control.

Shortcuts

Toolbar:
Keys: INS



Define Child command (Edit menu for the Objects/ Aggregates Window)

Use this command to insert the currently selected item in the Objects/ Aggregates list into the Child 
Objects list. Before selecting an item in the Objects/ Aggregates list as a child object, you must already 
have double-click an item in the Objects /Aggregates list at the bottom left to select an object as the 
active object to be displayed in the Object Name text field.

Shortcuts

Toolbar:
Keys: ALT+INS



Commit Changes command (Edit menu for the Objects/ Aggregates Window)

Use this command to commit all changes of a currently selected object displayed in the Object Name text
field at the top left corner.

Shortcuts

Toolbar:
Keys: ALT+ENTER



Delete command (Edit menu for the Objects/ Aggregates Window)

Use this command to delete a currently selected object in the Objects/ Aggregates list or the Child 
Objects list.

Shortcuts

Toolbar:
Keys: ALT+DEL



New Link command (Edit menu for the Object Links Window)

Use this command to insert a new link into the Links list. A link name must have been entered in the Link
Name text field.

Shortcuts

Toolbar:
Keys: INS



Commit Changes command (Edit menu for the Object Links Window)

Use this command to commit the changes of a currently selected link displayed in the Link Name text 
field at the top left.

Shortcuts

Toolbar:
Keys: ALT+ENTER



Delete command (Edit menu for the Object Links Window)

Use this command to delete a currently selected link in the Links list.

Shortcuts

Toolbar:
Keys: ALT+DEL



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in MindFrame, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in MindFrame,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your application offers. >>

Click To

Open a new document.

Open an existing document.    MindFrame displays the Open dialog box, in which you can locate 
and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, MindFrame displays the Save As dialog box.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the MindFrame window.    To display or hide the status bar, 
use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You can open 
multiple document windows to display different parts or views of a document at the same time.    If you 
change the contents in one window, all other windows containing the same document reflect those 
changes.    When you open a new window, it becomes the active window and is displayed on top of all 
other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

MindFrame displays a list of currently open document windows at the bottom of the Window menu.    A 
check mark appears in front of the document name of the active window.    Choose a document from this 
list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using MindFrame and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of MindFrame.



Context Help command 

Use the Context Help command to obtain help on some portion of MindFrame.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the MindFrame window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave in your 
application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the MindFrame window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    MindFrame determines which window 
is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    MindFrame determines which 
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item changes to 
Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

Use this command to clea all the text being selected in the active text edit control. When there is no 
selection, the menu item is grayed and inactive.



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a 
document using your application.    

If your application supports multiple document types and you want to have a distinct help topic for each, 
then use the help context i.d. generated by running the MAKEHELP.BAT file produced by AppWizard.    
Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the help 
context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the first 
document type supported by your application.    AppWizard produces an alias in the .HPJ file for your 
application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for that document type. >>





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx 
values from the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For 
example, AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>

    





Paste Link command (Edit menu)

<< Write a topic here that talks about the kinds of objects you expect users to embed in 
your application's documents. >>



Links command (Edit menu)

Use this command to display a    Links dialog box which lets you edit links between your 
document and other documents.

This command is unavailable if you have no links in your document.



Links dialog box

The following options are available in the Links dialog box:
Links

Displays all links in a document. The four columns contain the application, filename, item
name, and type or status of link.

Update
Select the type of link you want for the selected links in the Links box:
Automatic Inserts new data as soon as it is available.
Manual Inserts new data only when you ask for it by choosing the Update Now button.

Locked
Prevents updates to a selected link. If you lock a link, the Update Now option is 
unavailable.

Open Source
Opens the source of a selected link -- for example, choosing the Open Source button 
opens up a linked chart in Microsoft Excel if you have a Microsoft Excel chart linked to 
your document.

Update Now
Updates all links selected in the Links box, and then closes the dialog box.

Cancel Link
Breaks links for all selected links between data and the document, and then closes the 
Links dialog box.

Change Link
Displays a dialog box so you can change the selected link to receive data from another 
application, file, or item. 



Object verb (Edit menu) 

Use this command to open the application in which the selected object was created and 
display the object so you can edit it.    This command is available only when you have 
selected an existing object in your document.    When you finish editing and close the 
application window, <<YourApp>> incorporates the changes into your document.    This 
menu name changes depending on the object you select.

For example, << provide an example here that makes sense for your application >>

Shortcut
Mouse: Double-click the object with the left mouse button.



Insert New Object command (Edit menu)

Use this command to insert an object from another application.    The application supplying 
the object will become active on your screen.

Select the object you want to insert into your document using the Insert New Object dialog 
box.



Insert New Object dialog box

Choose the Object command from the Insert menu to insert an object from another 
application.    Select the object you want to insert into your document from the Insert New 
Object dialog box.
Object Type

Some common objects are drawings, graphs, spreadsheets, and equations.

    



Conduct User Analysis

The purpose of user analysis is to come up with the characteristics of target user groups, similar to what a
market researcher would do to identify target markets. Therefore the purpose is really two fold:

1) to identify critical characteristics, and
2) to segment users into groups based on these characteristics.

A brief description of intended users in a preliminary requirements specification will get us started on the 
task of user analysis. Through interviewing users, we can gather important information for further 
analysis. Once we have sufficient information about target users, we take the following steps to conduct 
the activity of user analysis:
1. Identify Analysis Factors Critical to Application
Examine the user information to identify the factors critical to the application. Common analysis factors 
are computer skill level, application-domain skill level, usage pattern, user roles, and cultural differences.
2. Discover Other Factors Critical to Application
There are many other possible factors that may turn out to be critical to an application. Try finding 
additional factors that are critical to your application.
3. Estimate Distribution of Users of Each Application-Critical Factor
Find the user distribution of all possible user groups for each of the application-critical factors. A careful 
user survey should provide us with such information.
4. Rank Distribution to Identify Major User Groups
If the previous step reveals fairly concentrated distribution of user groups, we can skip this step. However,
if the target user groups are loosely spread    and fragmented, we need to analyze the distribution further. 
The distribution ranking is significant for individual analysis factors, as well as for the combination of 
analysis factors. The probability of a user having a combination of characteristics is the product of 
individual distributions, a higher probability would reveal it as a major user group.

See Also
User Analysis Samples



Construct Task Model

Task model records a sequence of events that a user would have to go through to perform certain task. It 
is part of our human behavior as we were created in the image of God. In everyone's mind, all kinds of 
learned knowledge are represented hierarchically. Knowledge are either spatial or temporal, that can be 
represented with object model or task model respectively. Therefore, task modeling is simply to 
decompose a user task hierarchically into finer steps of events that a user would have to go through. The 
GOMS (Goals, Operators, Methods, Selection Rules) task model is a well-known approach among 
computer-human interface researchers. Although there are four components in a GOMS model, the 
underlying concept is still the hierarchical representation of event sequences.

Because the inherent design of the MindFrame application follows the simple and yet elegant design of 
our brain, a GOMS task model can be constructed with this application with ease.

If we use the example of user interface development, we would have a simple task model as follows:

Develop User Interface Application
1. Analysis Activities

1.1 Conduct User Analysis
1.2 Construct Task Model
1.3 Construct Object Model

2. Design Activities
2.1 Perform System-Level Design
2.2 Perform User Interface Metaphor Design
2.3 Perform Object-Oriented Graphical User interface Design
2.4 Perform Contextual Graphical User Interface Design

3. Implementation Activities
3.1 Implement GUI prototypes
3.2 Implement GUI software
3.3 Integrate GUI with application functional core

From the top-level task of "Develop User Interface Application", we hierarchically decomposed it into three
finer steps, and each in turn is decomposed further. In MindFrame application, the finer steps of a 
decomposition are represented as children classes of an aggregation (i.e. representing the higher-level 
step that contains them).

See Also
Task Modeling Samples, Object Model



Construct Object Model

Object model is not only useful in software development. It really is how human knowledge is represented
in our brain. The hierarchical structure of an inheritance hierarchy or an aggregation hierarchy, and the 
relationships among the classes are the foundation of human knowledge representation and how our 
brain functions.

The instances of a class is called an object, and the instance of a relationship is called a link.

A class also encapsulates the attributes and operations pertaining to a class. Each attribute also has 
facets of poss possible values, data type, etc.

See Also
Object Modeling Samples



Perform System-Level Design

The object model constructed may contain large number of classes, relationships, and their attriburtes, 
operations. All these elements of an object model must be accessible to the user through the graphical 
user interface. The graphical user interface must orderly presents these information to the user. The 
system-level design prioritizes and groups these object model information, so they can be orderly 
presented. Prioritizing and grouping also considers human coginitive capacity, that we can only pay 
attention to one thing at a time, and we have limited short-term memory in our mind to hold information for
further processing.

See Also
System-Level Design Samples



Construct Metaphor Models

Essential to the learning process of a human is the use of metaphors (i.e., analogies) and examples. 
Metaphors help users comprehending new knowledge through their known knowledge. An object model is
a form of knowledge representation. To help users learn to use an application, we devise metaphors to 
ease their learning process. Metaphor model maps to object model with their objects and relationships. 
Read the book: "Object-Oriented GUI Application Development" for detailed explanation. For information 
about the book, read About MindFrame... help topic.

See Also
Metaphor Modeling Samples



Construct Models of Life Forms

The first chapter of the book of Genesis recorded how our Lord God created the heavens and earth, 
'Thus the heavens and the earth were completed in all their vast array' (Genesis 2:1).

Various forms of lives were created on the third, the fifth, and the sixth day of creation:
1. Vegetation was created on the third day (Genesis 1:11-13):

11 Then God said, "Let the land produce vegetation: seed-bearing plants and trees on the land that 
bear fruit with seed in it, according to their various kinds." And it was so.
12 The land produced vegetation: plants bearing seed according to their kinds and trees bearing fruit
with seed in it according to their kinds. And God saw that it was good.
13 And there was evening, and there was morning-- the third day.

2. Life forms in the water and winged bird were created on the fifth day (Gen 1:20-23)
20 And God said, "Let the water teem with living creatures, and let birds fly above the earth across 
the expanse of the sky."
21 So God created the great creatures of the sea and every living and moving thing with which the 
water teems, according to their kinds, and every winged bird according to its kind. And God saw that it
was good.
22 God blessed them and said, "Be fruitful and increase in number and fill the water in the seas, and 
let the birds increase on the earth."
23 And there was evening, and there was morning-- the fifth day.

3. Land animals and creatures were created on the sixth day (Genesis 1:24-25):
24 And God said, "Let the land produce living creatures according to their kinds: livestock, creatures 
that move along the ground, and wild animals, each according to its kind." And it was so.
25 God made the wild animals according to their kinds, the livestock according to their kinds, and all 
the creatures that move along the ground according to their kinds. And God saw that it was good.

4. Man and woman were also created on the sixth day (Genesis 1:26:31)
26 Then God said, "Let us make man in our image, in our likeness, and let them rule over the fish of 
the sea and the birds of the air, over the livestock, over all the earth, and over all the creatures that 
move along the ground."
27 So God created man in his own image, in the image of God he created him; male and female he 
created them.
28 God blessed them and said to them, "Be fruitful and increase in number; fill the earth and subdue 
it. Rule over the fish of the sea and the birds of the air and over every living creature that moves on 
the ground."
29 Then God said, "I give you every seed-bearing plant on the face of the whole earth and every tree
that has fruit with seed in it. They will be yours for food.
30 And to all the beasts of the earth and all the birds of the air and all the creatures that move on the
ground-- everything that has the breath of life in it-- I give every green plant for food." And it was so.
31 God saw all that he had made, and it was very good. And there was evening, and there was 
morning-- the sixth day.

Although life forms were created "according to their kinds" (see Genesis 1:11, 12, 21, 24, 25), the only 
exception was the creation of man and woman'So God created man in his own image, in the image of 
God he created him; male and female he created them' (Genesis 1:27). Man were also blessed and 
entrusted to rule over other living creaturesGod blessed them and said to them, "Be fruitful and increase 
in number; fill the earth and subdue it. Rule over the fish of the sea and the birds of the air and over every
living creature that moves on the ground" (Genesis 1:28).

MindFrame can be used to construct models of life forms that reveal the hierarchical order and close 
connections among the created life forms. From the amazing DNA molecule and the vital and intricate 



cells to the multitudes of plant and animals, life on earth is truly a wonder that bear witness for our Lord 
God the creator and sustainer of heavens and earth and everything in it (Psalm 24:1).

See Also
Life form Modeling Samples



Construct Neural Models

Neural models are connectionist models devised by researchers that model higher-level human cognitive 
capabilities with lower-level neural networks. Each neuron is a processing unit with thousands of input 
and output connections. Many aspects of human coginition have been explained with neural models. 
MindFrame can be used to construct neural models which define neural cells and the connections among
them.

See Also
Neural Modeling Samples



Construct Ecological Models

In God's creation around us, there exists elegant order in many aspects. The food chain, the water cycle, 
biogeochemical cycles, and many phenomena that sustain lives are some examples of such order. 
MindFrame is also capable of modeling these ecological phenomena in the creation.

See Also
Ecological Modeling Samples



Construct Models of the Universe

From subatomic particles to the clusters of galaxies, the universe is created and sustained by God. These
things in the universe have the same elegant order as all the creation of God. MindFrame is capable of 
modeling these things in the universe.

See Also
Universe Modeling Samples



User Analysis Samples

User analysis is not only used in developing user interface application, but also in many other disciplines 
dealing with humans, such as product marketing and political campaigning. You can find a sample 
application in the directory samples\usranal.

The file market.frm contains the sample application that surveys target users based on some 
characteristics. The results can be used to segment them into target markets.



Task Modeling Samples

Task model is a hierarchical decomposition of event sequences. Therefore we can use the MindFrame 
application to model many kinds of human knowledge of this nature. The following samples come from 
the Holy bible and other areas of human activities. You can find these sample files under the directory 
samples\tskmodel.

1. The file exodus.frm contains the sample application that records the biblical event of the Exodus,
when Moses, under the guidance of God, led Israelites out of Egypt to the promised land of 
Canaan, the nation of Israel today. Please reference the section on bible types to find some 
verses related to this event. You should read the books of Exodus, Numbers, and Joshua in the 
Old Testament to find ore detailed information.

2. The file guiproj.frm contains the sample applicaiton that models the steps of user interface 
development project as described in the section of Construct Task Model.



Object Modeling Samples

An object model includes the class inheritance and aggregation hierarchies, relationships among classes,
and instances of classes and relationships. You can find the sample file under the directory samples\
objmodel.

The file BibleApp.frm contains a sample application described as follows:

Although the Holy Bible was written by closed to 40 co-authors in a duration span over 1500 years 
(from ~1440 B.C. to ~100 A.D.) and the Old Testament (39 books, ~27) was written in Hebrew while 
the New Testament (27 books, 10 co-authors) was written in Greek, the entire Bible is extremely 
consistent. This amazing consistency allows us to study the bible with a concordance of the Bible, 
which is an alphabetical index of all the words in the Bible showing every contextual occurrence of a 
word. The meaning of a Bible scripture may be understood by referencing other verses throughout 
the Bible containing the same key words. A typical reader of the Bible may study a scripture, and then
use a Bible concordance to locate several other verses containing the same key words in order to 
make clear of the meaning of the entire scripture. There are several difficulties with this manual 
process:

This involves lots of flipping back and forth between the Bible and a Bible concordance.
The existing books of concordance have been prepared with a single key word. For some key 
words, it is time-consuming to search through a long list of entries to identify the relevant verses.

In view of these problems, it would benefit many Bible readers by developing a software that would 
make it even more joyful to read the Scriptures. Several requirements are necessary for such an 
application:

A user can use one window to read through the Bible and select one or more key words in a 
verse to bring up a window with a list of their occurrences (i.e. a concordance of multiple key 
words).
A user can select one or more entries in a list of key word occurrences to bring up window(s) 
containing the relevant Bible verses.
To improve upon the manual process, we want to provide the additional features to allow users to 
quickly locate the verses of the counterpart of a type/anti-type (i.e. prefiguration, foreshadowing) 
or a prophecy/fulfillment.



System-Level Design Samples

System-level design prioritizes the object model elements and groups them into logical groups. Each 
element of an object model can be assigned a priority number. Members of a logical groupd would have 
the same priority number. A sample file BibleSys.frm is under the directory samples\syslevel. This 
sample continues the example presented in the Object Modeling Sample section.



Metaphor Modeling Samples
Metaphor modeling sample files are found under the directory samples\metaphor in this distribution.

1. The file truevine.frm contains the sample application of the metaphor of the True Vine.

2. The file yoke.frm contains the sample application of the metaphor of Yoke and Burden.

3. The file henchick.frm contains the sample application of the metaphor of Hen and Chicks.



Life-Form Modeling Samples
Lifeform modeling samples are found under the directory samples\lifeform in this distribution.

The file cell.frm contains a model of living cells. Cells make up all living creatures, including microbes, 
plants, animals, and humans. For example, a human life begins as a single cella fertilized eggthat grows 
into a new born baby with 2 trillion cells in nine months and multiplies to 100 trillion cells when the 
growing stops in human body. Cells carry out all functions of living creatures with specialized cell 
structures for specific functions. Inside a cell, there are organelles that produce energy (mitochondrion), 
synthesize proteins from amino acids (ribosome), manufacture other organelles (Golgi apparatus and 
endoplasmic reticula). Cell nucleus controls the functions of these interacting organelles and cell division 
process (mitosis). Each organelle has its amazing organization, for example, in mitochondrion, sugars are
broken down to produce energy through a sequence of 50 reactions, each with the help of a specific 
enzyme, a miniature assembly line (5 microns long in a human cell).



Neural Modeling Samples
Neural modeling samples are found under the directory samples\neural in this distribution.

The file connect.frm contains a neural model with a connectionist model called parallel distributed 
processing (PDP) developed by Jay McClelland and David Rumelhart (see Parallel Distributed 
Processing: Explorations in microstructure of cognition, Vol. 1, 2, MIT Press, 1986). This model can be 
used to model the representation of human knowledge by neural cells.

The Holy Bible is the epic of human knowledge. Although the Holy Bible was written by closed to 40 co-
authors in a duration span over 1500 years (from ~1440 B.C. to ~100 A.D.) and the Old Testament (39 
books, ~27) was written in Hebrew while the New Testament (27 books, 10 co-authors) was written in 
Greek, the entire Bible is extremely consistent.

In this example, we represented a tiny sample of the knowledge of the characters in the Holy Bible and in 
which book each appeared. In the drawing below there are two kinds of neural cells, mutually excitatory 
cells in white background and mutually inhibitory cells in gray background. By exciting one of the mutually
excitatory cells, the knowledge related to it can be retrieved. For example, if the cell "Genesis" is excited, 
it will excite the mutually inhibitory cell (1) and (2), which in turn will excite the mutually excitatory cells 
"GOD", "Adam", "Eve", "Noah", and "Abraham". The knowledge of all the characters appeared in the book
of Genesis is thus retrieved.



Ecological Modeling Samples
Ecological modeling samples are found under the directory samples\ecology in this distribution.

1. The file water.frm contains a model of the global hydrological cycle. It demonstrates the cycle of 
water moving in the creation. Water is the most precious resource provided by God, it sustains 
lives, cleanses our body, nourishes plants, cleans the environment, and many other purposes, "as
the rain and the snow come down from heaven, and do not return to it without    watering the earth
and making it bud and flourish, so that it yields seed for the sower and bread for the eater" (Isaiah
55:10).

2. The file foodchan.frm contains a model of a food chain. It demonstrate the delicate balance 
between the predator and the prey in the creation that forms a hierarchy. At the top of this 
hierarchy is the "Top Carnivore"flesh eating animals tha preying on other Carivores. At the bottom
of the hierarchy is the "Plant". As it was written in the Scriptures, "As the Lord God made all kinds 
of trees grow out of the groundtrees that were pleasing to the eye and good for food..." (Genesis 
2:9); "Do you hunt the prey for the lioness and satisfy the hunger of the lions when they crouch in 
their dens or lie in wait in a thicket? Who provides food for the raven when its young cry out to 
God and wander about for lack of food?" (Job 38:39-41); "Give thanks to the Lord, for he is 
good. ... and who gives food to every creature. His love endures forever" (Psalm 136:25); "Praise 
the Lord. ... He provided food for the cattle and for the young ravens when they call" (Psalm 
147:9).

3. The file carbon.frm contains a model of the global carbon cycle. As one of the major global 
biogeochemical cycles and the key element of life on earth, the carbon cycle is very complex. It 
involves all life forms on earth as well as the inorganic carbon reservoirs and the links between 
them.The most apparent mutually benificial part of the global carbon cycle is between plants and 
animals. As plants produces carbohydrates and oxygen in the process of photosynthesis using 
carbon dioxide and water as raw material, animals release carbon dioxide to the air through 
respiration. Carbon is also major fuel for mankind in the form of coal and petroleum. Global 
carbon cycle is also related to the global water cycle and the food chain. This sample can be 
expanded to show interaction with other global biogeochemical cycles. One can find many 
elements of the global carbon cycle in the scripture, "He cut down cedars, or perhaps took a 
cypress or oak. He let it grow among the trees of the forest, or planted a pine, and the rain made 
it grow. It is man's fuel for burning; some of it he takes and warms himself, he kindles a fire and 
bakes bread..." (Isaiah 44:14-15).

4. The file nitrogen.frm contains a model of the global nitrogen cycle. Nitrogen is the most common
element in the atmosphere. The air we breathe is 78% nitrogen and 21% oxygen, leaving only 1%
to be shared by other gases. It is one the elements that is necessary in the formation of protein, 
and a major element of plant fertilizer. Nitrogen cycle is helped by various bacteria carrying 
specific enzymes to carry out specific functions in the nitrogen cycle and to maintain its balance. 
Nitrogen cycle is also a critical process that treats the wastes of lives on earth. As the global 
carbon cycle, the global nitrogen cycle is also linked with the global water cycle and food chain.



Universe Modeling Samples
Universe modeling samples are found under the directory samples\universe in this distribution.

1. The file galaxies.frm contains a model of the stars and galaxies in the universe. The stars and 
galaxies are enormous in their expanse and energy. They demonstrate the enormous power of 
God the creator and sustainer. Despite their enormous dimensions, the stars and galaxies are 
well organized into elegant order. Galaxies contains a few hundred billion stars. Galaxies in turn 
are organized into clusters of galaxies. Clusters of galaxies form superclusters. Superclusters 
have been found to form "great walls" of elongated curving strings in the space. The universe is 
thought to be organized into a series of walls of galaxies, roughly 300 million light years apart, 
separated by voids. Many scriptures declared the mighty power of our Lord God, such as this one
from the book of Isaiah, "To whom will you compare me? Or who is my equal?" says the Holy 
One. Lift your eyes and look to the heavens: Who created all these? He who brings out the starry 
host one by one, and calls them each by name. Because of his great power and mighty strength, 
not one of them is missing (Isaiah 40:25-26).

2. The file particle.frm contains a model of the fundamental particles being studied by particle 
physcists. Currently there have been found three classes of fundamental particles: quarks, 
leptons, and bosons (gauge particles). Quarks make up hadrons, such as protons, neutrons, and 
mesons. Leptons include electrons, electron neutrinos, muons, tau particles, etc. Bosons are the 
carriers of the four basic interactions (i.e., gravitational, electromagnetic, strong, and weak 
interactions). There have been found photons (carriers of electromagnetic interaction), gluons 
(carriers of strong interaction), and W, Z particles (carriers of weak interaction).



Bible Studying Samples
We have provided many samples that covers the following categories of bible studying:

Metaphors are widely found in the Bible in which familiar figures are used to speak of other less 
familiar concept. Metaphor modeling samples are found under the directory samples\metaphor 
in this distribution.

Types are frequently found in the Old Testament which prefigure things to come in the New 
Testament, where one finds anti-types, the counterpart of types. Types/anti-types samples are 
found under the directory samples\types in this distribution.

Messianic Prophecies are widely found in the books of the Old Testament that foretold the coming
of a Messiah as the one and only Savior of the world, and later fulfilled in the New Testament in 
the ministry of the Lord Jesus Christ, who is the God manifested in the flesh. Messianic 
prophecies samples are found under the directory samples\messiah in this distribution.

End-Time Prophecies are found in both the Old and the New Testaments that foretold the return 
of our Lord Jesus Christ to judge the world, to destroy heavens and earth, to create new heavens 
and a new earth, and to reveal the glory of the Holy City, the new Jerusalem. End-time 
prophecies samples are found under the directory samples\end-time in this distribution.

Jesus' Parables are short tales that uses earthly things as analogy to convey spiritual meaning to 
the hearer. To understand a parable, you should pay attention to important features, and yet not 
make all details mean something.    Jesus' parables samples are found under the directory 
samples\parable in this distribution.



Bible Types/Anti-Types Samples
Types/anti-types samples are found under the directory samples\types in this distribution.

1. The file baptism.frm contains an example of a type/anti-type. In this example, the type is the 
Israelites crossed the Red Sea, and the anti-type is a believer receives water baptism.

2. The file passover.frm contains another example of a type/anti-type. In this example, the type is the 
blood of Passover lamb saved the Israelites, and the anti-type is the redemption of sins of the world 
by the blood of Jesus Christ.



Messianic Prophecies Samples
Messianic prophecies samples are found under the directory samples\messiah in this distribution.

1. The file SonOfGod.frm contains an example of a Messianic prophecy. In this example, in the book of 
Isaiah in the Old Testament, it was prophesied that the Son of God is to be given to the world, who 
Himself is the Mighty God and our everlasting Father (Isaish 9:6-7). This prophecy was fulfilled about 
700 hundred years later, when Jesus Christ was born and later preached the Gospel of Kingdom of 
God and gave us a new command: Love each other. There are many scriptures in the Gospels 
(Matthew, Mark, Luke, and John) recorded Jesus' ministry, where is was recorded that Jesus is Son 
of God (Matthew 3:16-17), Jesus is Himself God the Father (John 10:30).

2. The file crucify.frm contains an example of another Messianic prophecy. In this example, the 
crucifixion of the Messiah that saves the world was prophesied in the book of Isaiah (Isaiah 53:5-6). 
This prophecy was fulfilled when Jesus Christ died on the cross for the sins of the world, so that we 
might die to sins and live for righteousnessthe eternal life (I Peter 2:24).



End-Time Prophecies Samples
End-time prophecies samples are found under the directory samples\end-time in this distribution.

1. The file unknown.frm contains an example of an end-time prophecy. In this example, Jesus Christ 
told his disciples about the signs of the end of the age (Matthew 24). Jesus emphasized that the day 
and hour is not known to anyone, not even the angels in heaven, but God the Father alone (Matthew 
24:36). This prophecy is very important for us living in the end times when many false prophets claim 
to know the exact date and time of the end of the world, while the Scriptures told us clearly that only 
God knows it.

2. The file judgment.frm contains an example of another end-time prophecy. In this example, it is 
prophesied and recorded in many scriptures that the dead and the living will be judged by God (Jesus
Christ) when Jesus Christ returns.

3. The file newearth.frm contains an example of a prophecy about the destruction of the current 
heavens and earth, and the creation of new heavens and a new earth, and a new Jerusalem. There 
are a number of scriptures in the Bible prophesying about this event.



Jesus' Parables Samples
Jesus' parables samples are found under the directory samples\parable in this distribution.

1. The file sower.frm contains the example of the parable of the sower. In this example, Jesus used the 
parable of a sower and the outcome of seeds he scattered to indicate how Jesus preached the 
Gospel of God's kingdom and the outcome of people who heard it. It can be generally applied to what
happens to anyone who hears the Gospel from an evangelist.

2. The file 10virgin.frm contains the example of the parable of the ten virgins. In this example, Jesus 
used the parable of ten virgins to encourage the believers to stay fervent and be prepared at all times 
for the return of Jesus Christ, then they can enter the kingdom of God to have eternal life.



The True Jesus Church

By the will of God and the work of the Holy Spirit, the True Jesus Church was founded during 1917 by 
three believers from other Protestant denominations in Peking, China. The commission of the True Jesus 
Church is to restore the true church of the apostolic times for the end-time period. The true church is built 
on the foundation of the apostles and prophets, with Christ Jesus himself as the chief cornerstone. In him 
the whole building is joined together and rises to become a holy temple in the Lord (Ephesians 2:20-21). 
God also testified to the commision of the True Jesus Church by signs, wonders and various miracles, 
and gifts of the Holy Spirit distributed according to his will (Mark 16:20; Acts 14:3; Hebrews 2:4).

The General Assembly of the True Jesus Church was established during 1926 in Nanking, China. The 
True Jesus Church started to spread through the world. In a 1947 statistics, there were around 1,000 
churches and 100,000 believers of the True Jesus Church in China alone. After communist toke over 
China during 1949, the General Assembly moved to Taiwan, and the True Church continued to grow 
throughout the world. The International Assembly of the True Jesus Church was establish in 1967 and 
later moved to the United States to carry out further the challenging mission of world evangelism.

According to a 1992 statistics, the True Jesus Church has established over 500 churches and prayer 
houses throughout the world in more than 20 countries in five continents, with over 75,000 believers. 
These numbers did not include the churches in China. Although the believers in China had been severely 
persecuted under the communist rule over the past forty years. Many of the Chinese believers and 
servants of our Lord were martyred. But miraculously, by the Spirit of the Lord Almighty, the True Jesus 
Church continued to grow in China to more than 200,000 believers accroding to a recent estimate.

Basic Beliefs of the True Jesus Church
The Name of God - Jesus
The Holy Spirit and You
Are You in    the True    Church?
True Jesus Church Believers' Testimonies
True Jesus Church Locations



The Name of God - Jesus

Many think that Jesus is not the name of God. Some believe 'Elohim' is the name of God, whereas the 
others 'Jehovah' (Yahweh in Hebrew text). But, they are only titles. Elohim has the technical meaning of 
leaders with authority; governors or rulers or diviners (1 Samuel 28:13). Most often it had been used to 
refer to pagan or false gods (Judges 8:33). Whenever, the Bible says the chosen people of God relied on 
the name of the LordJehovah or Yahweh for salvation, it means they called upon the title denoting God for
deliverance. Jehovah means 'I am what I am'the Self-existing One. It was also a title used in the OT to 
distinguish God from other gods (Isaiah 42:8). Such a distinction was necessary because, in many 
occasions, the ignorance and naivety of Israelites and their contact with pagans led them to adopt 
paganistic practices and titles, which is called syncretism. And that mixed up their pure faith with heathen 
beliefs. In the book of Hosea, for example, the people of Israel addressed Baal 'Master'. So, it was 
essential to call Yahweh by another title, 'husband' in this case, to distinguish the Lord God from Baal 
(Hosea 2:16).

If the above two or other titles are names, then God would have many names. The people of God in the 
OT would not have to, from generation to generation, inquire after the name of God (Genesis 32:9,29; 
Judges 13:18; Proverbs 30:4). In this light, all the titles denoting God cannot be reckoned as the names of
God.

"I appeared to Abraham, to Isaac and to Jacob as God Almighty, but by my name the Lord I did not make 
myself known to them" (Exodus 6:3). God had no intention to make His Name known in the OT. Even 
when prophet Isaiah was moved by the Holy Spirit of the Lord to explain God's name, he could only 
describe is but not say it out (Isaiah 9:6-7). To the Hebrew, the name of a person summarizes his/her 
complete nature and character. To know God's name is to know Him in totality, and to call on His name is 
to appeal to Him by His character, personality, and attributes, each of them merely told a part of His 
nature.

However, in the NT, God reveals His name, which is Jesus to man. It also fulfills the prophecy: "Therefore 
my people shall know my name" (Isaiah 52:6; cf. Psalms 22:22; Hebrew 2:12). His name is the 
culmination of all the titles of God that reveals the complete nature of God. "And the Lord will become 
King over all the earth; on that day the Lord will be one and His name one" (Zechariah 14:9).

Jesus being God Himself in the flesh and in Him was the fullness of the Godhead bodily (John 17:6, 11, 
26; Collosians 1:19; 2:9). He exhibited the complete nature of God when He was on earth. In His prayer, 
Jesus was revealing the mystery that His name and His Father's name was the same (John 17:6, 11, 26). 
The full character of God is unveiling through the works Jesus and His disciples performed in His own 
name. Examples included healing (Acts 3:1-10), exorcising (Acts 19:13-17) and forgiving sins (Acts 
22:16).

Besides, John says explicitly that by believing in the name of Jesus, we may know that we have eternal 
life (1 John 5:13) and is the commandment (1 John 3:23). These prove that Jesus is the name of God, the
Father (Isaiah 35:4-6; cf. Luke 7:19-22)the only name given amongst us by which    we must be saved 
(Acts 4:12).



The Holy Spirit and You

1. Who is the Holy Spirit?
The holy Spirit is the Spirit of God, and also the spirit of Christ (Romans 8:9).

2. Why is it so important to receive the Holy Spirit?
When we received the Holy Spirit, the Spirit Himself testifies that we have become the children of God. 
God sets His seal of ownership on His children as a pledge guaranteeing the heavenly inheritance to 
those who have received the Holy Spirit (Romans 8:6; 2 Corinthians 1:21-22; Ephesians 1:13-14).

3. Is there any relationship between receiving the Holy Spirit and Salvation?
Yes. The Holy Spirit is not only a gift, but also indispensable for salvation. The Bible clearly states that 
unless we are born of water and the Spirit, we cannot enter the Kingdom of God (John 3:5).

4. Can we claim by virtue of belief, baptism, good works or fervent service to the Lord, we have 
already received the Holy Spirit?

No. The scriptures are clear in how we can tell we have received the Holy Spirit (Acts 19:1-2; 8:15-16; 
10:2, 22, 33; 1:4-5;; Titus 3:5).

5. What is the evidence of receiving the Holy Spirit?
The immediate evidence of receiving the Holy Spirit is speaking in tongues (Acts 2:4; 10:46; 19:6).

6. What is the meaning of speaking in tongues?
Speaking in tongues means that we are speaking to God and not to man, and when we pray in the Holy 
Spirit, we utter mysterious words, or sounds which are usually not understood by men. Speaking in 
tongues, or spiritual tongues, is not a worldly language (1 Corinthians 14:2, 10-16).

7. Who can receive the Holy Spirit?
Our Father in heaven gives the Holy Spirit to those who ask Him (Luke 11:13).

8. How do we know that we will definitely receive the Holy Spirit?
It is the promise of God. He will give His Spirit to everyone who asks. He says: "I will pour out my Spirit on
all people, I will put my Spirit in you" (Joel 2:28-29; Ezekial 36:27; Luke 11:11-13).

9. How do we receive the Holy Spirit?
We must believe and follow the Gospel of Salvation and repent, receive water baptism in the name of 
Jesus Christ for the remission of sins. It is essential that we pray for the Holy Spirit earnestly and 
persistently (Ephesians 1:13; Acts 5:32; 2:38; 19:2-7; 8:14-17; 1:14; Luke 11:5-13).
When praying for the Holy Spirit, we should begin by saying, "In the Name of the Lord Jesus Christ I pray.
Hallelujah, O Lord, please bestow your Holy Spirit on me." We must also pray with importunity (John 
14:26; Luke 11:8, 13). After having received the Holy Spirit we must do God's will and rely on His power to
bear spiritual fruit to glorify Him (Galatians 5:22-23; Ephesians 4:20-24).

The Holy Spirit is vital to our salvation. It is for our own benefit to know more about the Holy Spirit. Please 
come to a True Jesus Church near you to study the scriptures and pray for the Holy Spirit for your eternal 
salvation.



Basic Beliefs of the True Jesus Church

1. God was manifested in the flesh as the Lord Jesus Christ. He died on the cross for the remission of 
sins and was resurrected on the third day, then He ascended into Heaven. Jesus is the one and only 
Savior of the world, the Creator of heavens and earth, and the only true God. (1Timothy 3:16; 1 
Corinthians 15:3-4; Luke 2:8-11; Philipians 2:6-8; Acts 4:12)

2. The Holy Bible, consisting of the Old and New Testaments, is given by inspiration of God and is the 
sole foundation of truth and the standard of faith for the believers. (2 Timothy 3:16; 2 Peter 1:21; 
Galations 1:6-9)

3. True Jesus Church is the true church, established by Jesus Christ through the Holy Spirit of the end-
time ("Latter Rain") for the purpose of restoring the true church of the apostolic times. (Joel 2:23; 
Amos 9:11)

4. Water baptism is the sacrament for the remission of sins and for regeneration. It must be performed in
the name of the Lord Jesus Christ. The baptist must be one who has been baptized of water and of 
the Holy Spirit. The baptized, with the head bowed, must be completely immersed in living water. 
(Matthew 3:16; Acts 2:38; John 20:21-23, 19:30; Romans 8:16)

5. Receiving the Holy Spirit, which is evidenced by speaking in tongues, is the guarantee for the 
inheritance until the possession of the kingdom of Heaven. (Ephesians 1:13-14; Acts 10:44-47; 
Romans 8:16)

6. The sacrament of foot-washing enables one to have a part in the Lord Jesus Christ. It also serves as 
a constant reminder that one should have love, holiness, humility, service, and forgiveness. Every 
person who has received water baptism must have the feet washed once in the Name of the Lord 
Jesus Christ. Mutual foot-washing my be practiced when necessary. (John 13:1-17)

7. The Holy Communion is the sacrament in remembrance of the death of the Lord Jesus Christ. It 
enables the believers to partake of the flesh and blood of the Lord, and to be in communion with Him 
so that they can have eternal life and be raised on the Last Day. This sacrament should be held often.
Only one unleavened bread and grape juice shall be used. (1 Corinthians 11:26, 10:17; John 6:53-56;
Mark 14:24-25)

8. The Sabbath, the seventh day of the week (Saturday), is a holy day blessed and sanctified by God. It 
is to be observed under grace for the commemoration of God's creation and redemption, and with the
hope of eternal rest in the Kingdom of God. (Genesis 2:2-3; Exodus 20:8-11; Hebrews 4:9-11)

9. Salvation is given by the grace of God to believers through their faith in Jesus Christ. The believer 
must rely on the Holy Spirit to pursue holiness, to    honor God and to love mankind. (Ephesians 2:8; 
Hebrews 12:14; Ecclesiastes 12:13; Matthew 22:37-39)

10. The second coming of the Lord Jesus Christ will take place on the Last Day when He descends from 
heaven to judge the world. The righteous will receive eternal life and the wicked will be condemned. 
(Acts 1:11; 2 Corinthians 5:10; Matthew 25:31-34; 1 Thessalonians 4:16-17)



Are You in the True Church?

The New Testament defines church as the mystical body of Christ of which He is the head (Ephesians 
1:22-23), and a holy temple for the habitation of God through the Spirit (Ephesians 2:21-22). The true 
Church, established on the day of Pentecost (Acts 2:1-42), is "one flesh" with Christ (Ephesians 5:30-32). 
As the Church is the body of Jesus Christ, all the members have become one body by the baptism of the 
water (Galations 3:27-29). It is in Jesus Christ and of the Holy Spirit (1 Corinthians 12:13).

The unique nature of the true Church as the one body of Christ is attested to by the Scriptures: "There is 
one body and one Spirit..." (Ephesians 4:4; 1 Corinthians 10:17)

"For just as the body is one and has many members, and all the members of the body, though many, 
are one body, so it is with Christ. For by one Spirit we were all baptized into one bodyJews or Greeks,
slaves or freeand all were made to drink of one Spirit" (1 Corinthians 12:12-13)

"The Church is his body..." (Ephesians 1:23)

"Now I rejoice in my sufferings for your sake for the sake of his body, that is, the Church" (Colossians 
1:24)

From these verses it is clear that the Church is the body of Christ. As there is only one body of Christ, 
there is only one true Church which has "one faith, one baptism, one Spirit" with one Father and Jesus 
Christ as the Lord.

Thus, everyone must make sure of his salvation by finding the True Church. What are the requisites of the
True Church?

1. The Holy Spirit
The Church (ecclesia in Greek) is an assembly "called out" of the world by God, gathering to worship as 
server Him. In this community of faith, God's presence is evidenced by the Holy Spirit. Therefore the Holy 
Spirit, the Spirit of God, or the Spirit of Christ in a church (Ephesians 1:23) proves that God is with her (1 
John 3:24) and that she belongs to Christ (Romans 8:9). Through the Holy Spirit the Church has the 
power to retain and forgive sins (John 20:21-23; Matthew 16:19). Without having the Holy Spirit the 
Church is only a social community established according to human ideas.

2. The Miracles and Wonders
A second requisite for a True Church is the presence of miracles and wonders. These signs further testify 
the presence of God (Mark 16:17-18; John 3:1-2; 1 Corinthians 12:9; Luke 10:19) and confirm the Truth 
(Mark 16:20; Acts 14:3; Hebrews 2:3-4).

3. The Complete Doctrine of Salvation
A church that claims to have the power to perform miracles and wonders is not necessarily a true church, 
because Satan, the evil spirit can also perform miracles and wonders (2 Thessalonians 2:9; Matthew 
24:24). The third requisite of the True Church is the complete Gospel. The True Church must preach the 
message of salvation completely according to the Holy Bible, for without doing so she can never lead men
to the Kingdom of god (Matthew 15:14; 23:15)

Have you been seeking for a True Church that meets the requirements of God and manifests the divine 
power and love? If not, please come to the True Jesus Church and study    the word of God with us.



Testimonies of the True Jesus Church Believers

In the Apostolic times, the true church had many miracles and wonders to testify the presence of God 
(Mark 16:17-18; John 3:1-2; 1 Corinthians 12:9; Luke 10:19) and to confirm the Truth (Mark 16:20; Acts 
14:3; Hebrews 2:3-4). In the restored true church of the end-time, the True Jesus Church, God also 
confirmed the message of his grace by doing numerous miracles and wonders. But as when Jesus was in
the world, "He did many things. If every one of them were written down, the whole world would not have 
room for the books that would be written" (John 21:25). Here we offer the testimonies of two brothers to 
bear witness for our Lord. But the greatest miracles of all are being done around us everyday, which 
many people take them for granted. For as the Scriptures tell us, "God who made heaven and earth and 
sea and everything in them. In the past, he let all nations go their own way. Yet he has not left himself 
without testimony: He has shown kindness by giving you rain from heaven and crops in their seasons; he 
provides you with plenty of food and fills your hearts with joy" (Acts 14:15, 17).

Amazing Grace
The Lord will call upon me, and I will answer Him
God's power is made perfect in weakness



Amazing Grace

by Brother Philip Taylor

Hallelujah, in the name of the Lord Jesus Christ, I humbly offer my testimony.

Those who are well do not need a physician, but those who are sick. (Luke 5:31)

Before 1983, I was a healthy young man. I could do anything I wanted, and no one could tell me what to 
do, not even God! In spite of my sinful attitude and arrogant nature, God still loved me. There were two 
events that were unfolding in 1983 that brought me to God, and were the first of many blessings I have 
received from Him. The first experience was in the summer of 1983 when I first met the woman who 
would later become my wife. She was visiting America from Taiwan. She was only planning to stay for one
month; therefore, I believe that the way we met could only have been arranged by God. We got along so 
well that on February 4, 1984, we were married.

The second event occurred also in the summer of 1983. I started to feel ill and went to see my doctor. I 
was given a complete examination, as well as numerous tests, yet my doctor could not find the problem. 
Eight days after my wedding, I was admitted to the hospital. A whole new series of tests was done for 
about a week. It was finally determined that I had lupus, a chronic auto-immune diseasemy immune 
system turned against my own body. The symptoms of lupus are many: inflammation of the joints, 
constant fatigue, loss of appetite, insomnia, abnormal blood pressure, nausea, arthritis, a butterfly rash 
over the face and body, tenderness and swelling of the joints, and visual hypersensitivity to the sun. In 
addition to having lupus, I suffered a mild stroke. Furthermore, my newly wed wife from Taiwan knew very
little English. When I did not know what to do, I prayed to God for help. I went to several churches in the 
San Diego area. Although my physical condition remained the same, I was nevertheless drawing closer to
God.

At the end of May 1988, my wife and I took a trip to Taiwan to visit my mother-in-law, who was suffering 
from end-stage diabetes. While there, for the first time I observed the Sabbath worship in the True Jesus 
Church, where my wife has been a member since childhood. I was surprised to hear them pray in spiritual
tongues. However, as I watched them I saw that they were very sincere. When I knelt down, I prayed hard
and felt very warm and tranquil.

I perceived that the True Jesus Church was different from other church. After returning from Taiwan we 
were pleased to find the True Jesus Church in Garden Grove, California. It was such a long drive from 
San Diego that we had to stop and rest at the house of our uncle, Deacon Yang, on the way home. In 
early October 1989, on a Sabbath afternoon, we stopped as usual at Deacon Yang's house for fellowship 
and prayer. Praise the Lord! I received the Holy Spirit. I perspired heavily and started to speak in tongues,
uttering things I could not understand. Hallelujah! I was filled with the joy of the Spirit.

On December 29, a spiritual convocation was held in the Garden Grove church. During the concluding 
prayer, I had a vision. First, I saw Jesus on the cross with his head bowed down. I then saw blood running
down from both his hands and his feet. Next, I saw myself being prepared for baptism. I was completely 
immersed in the water. Then, looking up through the water to the sky, I saw a huge hand coming down 
towards me. When it touched me, I started to sweat profusely.

This was the first time I knew that I was going to be cured of my lupus. On December 31 of 1989, I was 
baptized. Praise God! After the baptism, I felt as if a thousand pounds had been lifted off my shoulders. I 
was able to put away my protective sunglasses. My face was not even burnt by the sun. How wonderful!

On January 1, 1990, God's blessings poured upon me again. It was a cold and stormy night, yet I felt as if
I were burning up inside, and had to get out of bed and kneel down to pray. I saw another vision: a huge 
hand came down through the storm and reached me. I heard a voice saying, "Do not be afraid, I want to 



show you something." I felt someone take hold of my hand, lift my soul into the sky, and break through 
what seemed to be the very highest cloud. It felt so peaceful and tranquil, far more than mere words could
possibly describe. I was in heaven. I saw that everything was shining and paved with soft gold. I wanted 
very much to stay, but Jesus told me, "No. It is not time yet." Then, Jesus brought me back to the world 
and started to heal me. I first felt Him working inside my head, healing the effects of my stroke. Then I felt 
His hand move down onto my chest, take hold of my heart, and turn it completely around. He proceeded 
to do likewise to all my other internal organs. In the meantime, Jesus was telling me prepare for His 
ministry and help establish the True Jesus Church in San Diego. Praise the Lord, I was totally healed. 
Since then, my doctor has examined me, amazed that I had been healed so completely.

May all the glory and praise be unto Him. Amen.



The Lord will call upon me, and I will answer Him

by Brother Larry A. Estrada

I was first diagnosed with cancer in August 1990. Since then, my doctors have tried to control the disease 
with surgery, chemotherapy and radiation. However, they are, at this time, concerned that the disease is 
what they term as 'rapidly advancing', and are encouraging me to try a higher dose of chemo drugs. If I 
can picture a drowning man clinging to the last straw, then it would appear to me that the doctors' 
recommendations would seem viable. For the past few months, I have been wrestling within myself, and I 
have this week come to the conclusion that it is only our Almighty God who can help me. And, it is with 
this plea for mercy from a compassionate God that I am standing here before you today.

You see, my father, two younger sisters and a few relatives have died of this terrible disease within a 
short period of their doctors' diagnosis. I have often wondered if, I, too, will perish in the same way. I have 
also heard that, if I die in these end time, it would only be a short while, before Jesus comes and my 
family would join me anyway. I have thought about the logic of this assumption, and wondered if, perhaps,
I could look at it a little differently.

Psalm 91 verses 14, 15, and 16 often bring me hope and comfort.

14 "Because he loves me," says the LORD, "I will rescue him; I will protect him, for he acknowledges
my name.
15 He will call upon me, and I will answer him; I will be with him in trouble, I will deliver him and 
honor him.
16 With long life will I satisfy him and show him my salvation."

These verses transport me back to my high school days when I read the Bible for the first time and 
understood it to be the words of God. It was not until over thirty six years later that I got baptized, but as I 
look back, I can see how our Lord Jesus brought me to the true church. And while I have been ill over the 
past three years, there is no doubt in my mind that God has given me His protection all the way.

Earlier on, I brought up the fact about us living in 'these end times', and by the grace of God, He has 
made Himself known to me so that I can work out my salvation. I know also that in our church, we believe 
that God has commissioned us to preach the gospel to all nations until the Second Coming of Jesus 
Christ. In Matthew 9:37 Jesus said to His disciples, "The harvest is plentiful but the workers are few." If 
this verse means anything to me; if these words were spoken from the mouth of our Lord, then I certainly 
have not yet fulfilled my role in these end times.

It is not enough that by the grace of God, I have a chance to get to know Him. It is not enough that by the 
grace of God, I have the love of my family and of the brothers and sisters of the church. It is no enough 
that by the grace of God, I have enjoyed His protection throughout my illness. It is not enough, because I 
have yet to boldly share the faith that we proclaim in our church that we have received divine revelation of
the Truth, that we are endowed with the Holy Spirit, and confirmed by signs and miracles.

At this time, my family and I can relate to the Israelites as they stood at the edge of the Red Sea and 
watched in terror at the advancing armies of Pharaoh. We can also understand how they must have 
thought it impossible, when Moses told them that they needed only to be still, because the Lord would 
fight for them. Yet, it is written in the Bible that God opened a way for them to cross the Red Sea safely, 
and in Exodus 14:31 it says, "And when the Israelites saw the great power the Lord displayed against the 
Egyptians, the people feared the Lord and put their trust in Him." In this way, God once again gained glory
for Himself.

In this testimony, I recollect my youthful days. Many of us in the congregation are here for the National 
Youth Theological Seminar. I cannot recapture my youth, but I want you to know that there is no greater 



blessing than to be given the opportunity to serve the Lord in this way. I encourage you to continue in your
efforts to seek the Truth, because there is no amount of worldly wisdom, wealth or health that can keep 
the soul at peace with God.

And while I may not be able to recapture my youth, I end this testimony with a plea for mercy from the 
only Living God so that I can reciprocate His ultimate sacrifice for me and for all mankind by being a good 
witness for Him. I cannot do this alone. I need all the help you can give me. I am not worthy to compare 
myself with Moses, yet I need the kind of help that Moses received from Aaron and Hur to win this 
spiritual battle. I need your continued prayers so that I can be a good Christian soldier, and know that our 
Lord Jesus did not die in vain for me.

(Brother Larry A. Estrada gave this testimony to a group of youth in August 1993. He was later received 
into the arms of our Lord in December 1993 after suffering from cancer for three years. During those three
years of illness, with strength from our Lord, he was a constant inspiration to other church members. In 
times of trial and suffering, he rejoiced in our Lord always. A few days before his departure, he suddenly 
woke up from sleep and cried out, "Lord! Here I am!"
He died in peace without pain in the presence of his family. We pray to our Lord to comfort his wife and 
two children and to provide for them in the coming years.)



God's Power is Made Perfect in Weakness

by Brother Geoff Lee and Sister Helen Lee

Hallelujah, we would like to present our testimony in the name of our Lord Jesus Christ.

But He said to me, "My grace is sufficient for you, for my power is made perfect in weakness. "Therefore I
will boast all the more gladly about my weakness, so that Christ's power may rest on me. (2 Corinthians 
12:9)

I grew up in a Christian family, my parents are church members of other Christian denomination in 
Taiwan. My wife had also received baptism more than 10 years ago in other denomination. When we 
were church members of various denominations, we had never heard of any testimonies of visions, 
dreams, and miracles. Above all, we had very little knowledge regarding the Holy Spirit, let alone 
experiencing them. This changed after we were lead to this church by the grace of God, we started to 
have visions and dreams of our Lord Jesus Christ. At first, we thought these to be the grace of God 
edifying us. We thought these to be very personal experiences, and not something we should talk about. 
Later on, a pastor told us that we should share our experiences with others to bear witness for our Lord 
Jesus Christ, to encourage truth seekers in their search of God, and to strengthen the faith of others, and 
to have fellowship with our brothers and sisters.

The following is our testimony:

In the summer of 1992, my wife signed up a swimming lesson for our son (who is 8 years old now). She 
met a sister of this church. This sister invited her to come to a Spiritual Convocation. Although we have 
been church members of another denomination for several years, we had been constantly seeking a 
church that is truly guided by God. That's how we started being truth-seekers of the True Jesus Church. 
The first time I came to this church, I was surprised how the church members prayed. Following the 
suggestion of a church brother, I studied the Book of Acts, especially chapter 2, and come to better 
understanding of the Holy Spirit and the gift of tongues. As we come to Sabbath services weekly, we 
found the sermons to be always faithful to the Scriptures from both the Old and the New testaments. God 
also opened our minds, so we were able to truly understand the words of God. Amazingly, each week, the
sermon always included something we were eager to know more about. We felt the omniscient God 
knows exactly what our needs are.

In December of 1992, we planned to go skiing in Lake Tahoe area, but the weather was awful (heavy 
snow in the mountains and raining on the way to the ski resort). We prayed to our Lord for better weather 
so we can make the trip. The weather did turn sunny as we embarked on our trip. It was sunny for all four 
days while we skied. It started raining again until after we came back from the ski trip. One day during our
ski trip, I was on a lift chairwhich carries skiers to a higher altitudeI looked around the beautiful scenery 
and was overwhelmed by the remarkable creation of God. Later that day I had a bad fall on the slope, 
although I tried but couldn't get back on my feet. It hurt so much I felt my legs were going to break. There 
was no one around to help me, I prayed to God for help, and miraculously I was right back on my feet 
again without any pain in my legs. I couldn't figure out how I got up until I heard a similar testimony 
several months later, then I realized it was our Lord Almighty who lifted me up.

After we came home from the ski trip, I had a dream one night. In the dream, the Lord Jesus Christ put 
me floating in the air. I felt I was undergoing a thorough physical examination. Then He put a small object 
in my body to cure my internal hemorrhage that I had for a couple of years. In the same dream, I was 
kneeling down and prayed in a tongue. Afterward I was put into a place with gold objects orbiting in the 
sky. As I woke up, I had the urge to pray and to say Hallelujah repeatedly. I also had strong desire to 
study the Scriptures to learn more about the words of God.

Afterward, we experienced even more grace of God. When we learned that a Spiritual Convocation was 
going to be held in late May of 1993 at the True Jesus Church in San Jose,    California, we decided the 



whole family would receive the water baptism then. One night in early May, my wife had a dream. In the 
dream, she was praying in a tongue at home and I walked over to her and asked her "How come you 
have received the Holy Spirit, and I haven't?" She turned her head and ask our Lord Jesus Christ who 
was beside her, "Yea, How come I have received the Holy Spirit but not he?" Jesus said gently, "Don't 
worry, he will receive the Holy Spirit after the water baptism." She continued to pray until she woke up 
from the dream. We knew it was the promise of God and will be fulfilled. We kept on studying the Bible 
and praying everyday. One day before our water baptism, pastor Lo and a brother came to visit us. As we 
started to pray, my wife had the vision of our Lord Jesus Christ standing before her, she couldn't help and 
let out all her sufferings throughout the years to God. The Lord Jesus gently petted her head three times 
and said, "Child, I know, I know..." That's how she received the Holy Spirit, it was exactly the same scene 
as in her dream earlier. On the 7th day from the day my wife received the Holy Spirit, we were praying in 
the morning at home. My wife had the vision of the Glory of God floating before her eyes to my side and 
then heard me started praying in a tongue. Praise the Lord for His blessing, that my wife and I are in one 
heart under our Lord Jesus Christ and pray together everyday.

Andrew is our first born son, since he was 4, he started having chronic nose-bleeding because of allergy. 
His nose-bleeding problem can occur at any moment, even when he is asleep. It got worse over the 
years. In the spring of 1993, it became worse because of the high pollen-count in the air in the Bay Area. 
It was very painful for him when he was at school, his nose is always stuffed, his eyes are red, and his 
face swollen. It was hard for him to fall asleep at night, because he felt like being choked to death. He 
would be fussy all night and crying a lot. We have tried all kinds of medicine, and there was no cure for 
him. One night, until 2 in the morning, he finally went to sleep, my wife and I couldn't sleep and started 
worrying about Andrew's coming years. We felt sad and knelt down to pray to our Lord Jesus Christ. We 
prayed to God to take care of our son and cure his illness. Afterward we went back to sleep, that night I 
had a dream, in the dream our Lord Jesus Christ was holding Andrew passionately in his arms. When I 
told my wife about it in the morning, we felt Andrew was going to be cured of his severe chronic allergy. In
a couple of days, his nose started to clear and breathed normally. God listened to our prayers and had 
mercy on us and our son.

On December 25, 1993, the whole family attended the Spiritual Convocation at the San Jose church. 
During the afternoon prayer session, Andrew had a vision while he was praying, he saw our Lord Jesus 
dressed in shiny white garment and His head was bright and glorious. Lord Jesus walked among church 
members and laid His hand on several people, including Andrew. When Andrew saw our Lord leaving, he 
quietly said, "Pass me not, Lord!" And our Lord Jesus gently replied, "I am here.", then a dove flew out 
and landed on Andrew's shoulder. Andrew received the Holy Spirit and started praying in a tongue, he 
was in tears but felt very peaceful and sinless. The next morning, Andrew prayed with my wife and I 
together, he had the vision of our Lord Jesus again, he saw our Lord came before him and looked at him 
while he was praying. Andrew was moved to tears. When Jesus left, a dove flew to Andrew with a glorious
star on the head and grabbing a gold and shiny gift box on the feet. The dove dropped the gift box in front
of Andrew, and landed on his shoulder again while Andrew continued to pray. The dove flew away when 
the praying stopped. When Andrew told me his vision the previous night, I didn't know what it all meant. 
But when he told me about the second vision, praise our Lord for opening my mind, that I realized Andrew
had received the gift of the Holy Spirit. Our Lord had mercy on our family and blessed us greatly with His 
abundant grace. Helen and I had always worried about Andrew and prayed for him a lot and asked our 
Lord's guidance to bring him up as a child of God. Our Lord answered our prayer with the greatest gift of 
all, and gave Andrew His Holy Spirit.

Thanks be to our Lord Jesus Christ whose abundant love and grace have given us many edifying 
experiences. Even when we were still sinners, God lead us and poured out his grace on us abundantly. 
Praise and glory and wisdom and thanks and honor and power and strength be to our God for ever and 
ever. Amen!



Locations of the True Jesus Church

The True Jesus Church has established over 500 churches and prayer houses throughout the world in 
more than 20 countries in five continents. We have complete list of the True Jesus Churches in Australia, 
Canada, Europe, Hong Kong, Japan, Korea, New Zealand, Singapore, U.K., and U.S.A.,    but only 
scattered information of other churches around world. If you don't find a church location near you, please 
contact the following:

International Assembly of the True Jesus 
11236 Dale Street
Garden Grove, CA 92641, U.S.A.
Tel: (714)539-1329
Fax:(714)539-9722

Or, contact a church location or a regional office nearest you. They will be more than happy to provide 
you with more information.



Regional Offices of the True Jesus Church

International Assemblies International Assembly of the True Jesus Church
11236 Dale Street
Garden Grove, CA 92641, U.S.A.
Tel: (714)539-1329
Fax:(714)539-9722

General Assemblies
Indonesia General Assembly in Indonesia

Jl. H. Samanhudi No. 23
Jakarta 10710, Indonesia
Tel: 62(21)345-0646
Fax: 62(21)345-0614

Korea General Assembly in Korea
349-3 Daebang-Dong
Dongjak-Gu
Seoul, Korea
Tel: 82(2)814-4367
Fax: 82(2)817-9084

Malaysia/Singapore General Assembly - Malaysia/Singapore
51 Jalan Jarak, Off Jalan Kapar
41400 Klang, Selangor Darul Ehsan
W. Malaysia
Tel/Fax: 60(3)342-6234

Sabah General Assembly - Sabah
P.O.Box 10510
88805, Kota Kinabalu
Sabah, E. Malaysia
Tel: 60(88)239-720 or 230-327
Fax: 60(88)233-661

Taiwan General Assembly of The True Jesus Church in Taiwan
180 Song-Tsu Road
Taichung, Taiwan 406
Republic of China
Tel: 886(4)230-6960
Fax: 886(4)230-6968

U.K. General Assembly in United Kingdom
Boyd Street, Shieldfield
Newcastle upon Tyne NE2 1BS
England, U.K.
Tel: 44(91)232-4836
Fax: 44(91)233-1169 or 295-3127

U.S.A. General Assembly in United States
11236 Dale Street
Garden Grove, CA 92641
U.S.A.
Tel: 1(714)530-3450 or 539-0480
Fax: 1(714)530-3450

Coordination Boards/ Committees



Australia Coordination Board in Australia
8 Dickson Street
Strathfield, NSW 2135
Australia
Tel: 61(2)764-4531
Fax: 61(2)905-4900

Canada Canadian Coordination Council
305 Industrial Parkway South
Unit 18
Aurora, Ontario
Canada L4G 3V8
Tel: 1(416)713-0656
Fax: 1(416)713-0658

Central & South 
Americas

Central & South Americas Coordination Center
Loyola 300, Bs. As. CAP. FED.
Argentina
Tel: 54(1)431-0908
Fax: 54(1)622-6288 or 982-0487

Europe Comite de Coordination European
Veritable-Jesus-Eglise
1, rue des Pinsons
77420 Champs Sur Marne
France
Tel/Fax: 33(1)6468-7995

India Coordination Board in India
5 Prabhudoss Street
Pasumppn Nagar, Pammal
Madras 600 075
S. India

New Zealand New Zealand Coordination Committee
2A Queens Way
Three Wings, Auckland
New Zealand
Tel/Fax: 64(9)630-9413

True Jesus Churches around the World

Africa Please contact International Assemblies

Argentina
Buenos Aires Buenos Aires Church

Calle Avellaneda 925
Bs. As. CAP. FED.
Argintina
Tel: 54(1)431-0908 or 982-0487
Fax: 54(1)982-0487

Australia
Brisbane Brisbane Church

95 Masthead Drive
Raby bay, Cleveland, QLD 4163



Brisbane, Australia
Tel: 61(7)821-2184
Fax: 61(7)821-2609

Melbourne Melbourne Church
84 Watts Street
Box Hill North
Melborne 3129, Vistoria
Australia
Tel: 61(3)898-1174
Fax: 61(3)857-5311

Perth Perth House of Prayer
23 Freedman Way
Winthrop
Perth 6150
Western Australia
Tel/Fax: 61(9)332-5405

Sydney Sydney Church
465 Victoria Road
Rydalmere
Sydney, NSW 2116
Tel: 61(2)638-6305/764-4531
Fax: 61(2)905-4900

Canada
Alberta Edmonton Church

9103-176 Avenue
Edmonton, Alberta
Canada    T5Z 2M1
Tel: 1(403)476-9575 or 462-1179
Fax: 1(403)483-6430

Worship Services
Saturday..................10:00 am

British Columbia Vancouver Church
3488 Dalebright Dr.
Burnaby, B.C.
Canada    V5A 3E9
Tel: 1(604)420-9828 or 434-8833
Fax: 1(604)420-9828

Worship Services
Saturday...................2:00 pm

Ontario Toronto Church
369 Harbord Street
Toronto, Ontario
Canada    M6G 1H8
Tel: 1(416)533-7428
Fax: 1(416)830-0018

Worship Services
Friday.......................8:00 pm
Saturday....2:00 pm & 3:00 pm

Europe
France Paris Church

Veritable-Jesus-Eglise
1, rue des Pinsons
77420 Champs Sur Marne
France
Tel/Fax: 33(1)6468-7995

Austria Salzburg House of Prayer



c/o H.M. Ko
Elsa-Brandstromstr. 3
A-5020 Salzburg
Austriche
Tel: 43(662)242-605
Fax: 43(662)842-324

Germany
Heidelberg Heidelberg House of Prayer

Postfach 106147
6900 Heidelberg
W. Germany
Tel/Fax: 49(6221)164-081

Hong Kong/ Kowloon
Hong Kong Hong Kong Church

1/F & 2/F
2-6 Fortress Hill Road
North Point
Hong Kong
Tel: (852)570-2423
Fax: (852)858-8863

Tai Po Church
Flat B, 1/F, Mei Lai Building
No. 10, Wan Tau Kok Lane,
Tai Po, Hong Kong
Tel: (852)656-0564

Kowloon Ap Chau Church
Kowloon, Hong Kong
Tel: (852)679-9325

Cheung Muk Tau Church
Kowloong, Hong Kong

Kowloon Church
168 Prince Road, 1/F
Wongkok, Kowloon
Hong Kong
Tel: (852)380-2180
Fax: (852)395-2315

Sha Tau Kok Church
Kowloon, Hong Kong
Tel: (852)674-6057

India Please contact regional office

Indonesia Please contact regional office

Japan
Konan Konan Church

3-3-1 Minami Eganosyou
Habikonoshi
Osakafu, Japan
Tel: 81(72)954-5896



Maebashi Maebashi Church
Maebashi, Japan

Osaka Osaka Church
Osaka, Japan
Tel: 81(6)681-9488
Fax: 81(6)681-9235

Tokyo Tokyo Church
No. 5-13-21, Shimoigusa
Suginami-Ku, Tokyo
Japan
Tel: 81(33)390-2645
Fax: 81(33)814-5063

Korea
Andong Andong Church

156-57 Pyunghwa-dong
Andong City
Kyungsangbook-do
Korea
Tel: 82(571)52-3207

Ansan Ansan House of Prayer
603-10 Palgok-Ri Banwoel-Myun
Hwasung-Goon Kyounggi-do
Korea
Tel: 82(345)85-2394

Chungju Chungju Church
1-13 Deasung-Dong
Chungju-City
Chiingchungbook-Do
Korea
Tel: 82(431)3-3705

Daegu Daegu Church
849-1, Sinchun 3-dong
Dong-gu, Daegu-city
Korea
Tel: 82(53)752-3249

Daejun Daejun Church
71-1 Chun-Dong Dong-Gu
Daejun-City
Choongchungnam-Do
Korea
Tel: 82(42)283-3865

Hwasan Hwason Church
Gajang-ri, Hwasan-myun
Haenam-goon, Junranam-do
Korea
Tel: 82(634)32-7170

Inchun Inchun Church
106-2 Kansuk-Dong Namdong-Gu
Inchun-City
Korea



Tel: 82(32)427-7460

Jangsuengpo Kueje Church
497-1 Nuongpo-dong
Jangsuengpo-city
Kyungsangnam-do, Korea
Tel: 82(558)681-3550

Junju Junju Church
600, 1-Ga Pyunghwa-Dong
Junju-City
Junrabook-Do
Korea
Tel: 82(652)223-6751

Kangjin Kangjin Church
Songsan-ri, Chilryang-myun
Kangjin-goon, Junranam-do
Korea
Tel: 82(638)32-7738

Kimchun Kimchun Church
387-9 Pyunghwa 1-Dong
Kimchun-city
Kyungsangbook-Do
Korea
Tel: 82(547)434-2071

Kwangju Kwangju Church
505-27 Cyerim-dong
Kwangju-city, Junranam-do
Korea
Tel: 82(62)522-2339

Mokpo Mokpo Church
549-1 Okam-dong
Mokpo-city, Junranam-do
Korea
Tel: 82(631)73-5732

Namwon Namwon Church
277 Noam-dong
Namwon-City
Junrabook-Do
Korea
Tel: 82(671)625-6219

Osan Osan House of Prayer
46-8 Kwol 3-Dong
Osan-City
Kyounggi-Do
Korea
Tel: 82(339)73-2641

Pusan Pusan Church
95-3 Boksan-dong
Dongrea-gu
Pusan, Korea
Tel: 82(51)553-0277



Samgye Samgye Church
279 Samgye-Ri
Samgye-Myun, Imsil-Goon
Junrabook-Do
Korea
Tel: 82(673)42-7619

Seoul Daebang Church
349-3 Daebang-Dong
Dongjak-Gu
Seoul, Korea
Tel: 82(2)815-1344

Dongboo Church
3-12 Hoegi-Dong
Dongdaemon-Gu
Seoul, Korea
Tel: 82(2)966-4294

Eunpyung House of Prayer
424-1 Galhyun-Dong
Eunpyung-Gu
Seoul, Korea
Tel: 82(2)387-6119

Kangnam Church
71-24 Samsung-Dong
Kangnam-Gu
Seoul, Korea
Tel: 82(2)514-8557

Nokbun Church
53-99 Nokbun-Dong
Eunpyung-Gu
Seoul, Korea
Tel: 82(2)355-8851

Soomoon Soomoon Church
Soomoon-ri, Anyang-Myun
Jangheong-goon, Junranam-do
Korea
Tel: 82(638)32-7738

Soowoun Soowoun Church
281-5 Youlljun-Dong
Soowoun-City
Kyounggi-Do
Korea
Tel: 82(331)293-3504

Ssangchi Ssangchi House of Prayer
Sinchon Gumsung-Ri
Ssangchi-Myun
Soonchang-Goon, Junrabook-Do
Korea
Tel: 82(674)52-2377

Suchun Suchun Church
Gunsa 1-Ri, Suchun-Up



Sunchun-Gun, Choongchungnam-Do
Korea
Tel: 82(671)34-8430

Suhdo Suhdo Church
Suhdo-Ri, Samae-Myun
Namwon-Goon, Junabook-Do
Korea
Tel: 82(671)34-8430

Youngkwang YoungKwang Church
Namchun-Ri, Youngkwang-Up
Youngkwang-goon, Junranam-do
Korea
Tel: 82(686)52-0018

Youwoochi Youwoochi House of Prayer
Maam-Ri, Woonam-Myun
Imsil-Goon, Junrabook-Do
Korea
Tel: 82(681)32-5521

Malaysia-Sabah Please contact regional office

New Zealand
Auckland Auckland Church

42 The Drive Epsom
Auckland, New Zealand
Tel: 64(9)638-6426
Fax: 64(9)630-9413

Chirstchurch Christchurch House of Prayer
7 Whiteleigh Avenue
Christchurch, New Zealand
Tel/Fax: 64(3)384-1194

Philippines
Manila Manila Church

Morales Building, 2nd Floor
R. Magsaysay Blvd. Cor.V.Mapa Street
Sta. Mesa
Metro Manila
Philippines 2806

Mansilingan Mansilingan Church
P.O.Box 840
Mansilingan
Bacolod City
Philippines 6001

Pagadian Pagadian Church
Bag-Ong Silang
Balangasan
Pagadian City
Philippines

Singapore



Adam Road Church
17-D Adam Road
Singapore 1128
Republic of Singapore
Tel/Fax: 65(467)2315

Singapore Church
34 Lorong H, Telok Kurau
Singapore 1542
Republic of Singapore
Tel: 65(345)8056

Taiwan Please contact regional office for additonal locations

Chung-Li Chung-Li Church
42 Ai-Kwo Rd.
Chung-Li, Taiwan 32011
Republic of China
Tel: 886(3)422-7266

Hsin-Chu Hsin-Chu Church
246 She-Chie St.
Hsin-Chu, Taiwan 30008
Republic of China
Tel: 886(35)251-573

Kao-Hsiung Kao-Hsiung Church
69 Chun-Hwa 3rd Rd. Chiangchin District
Kao-Hsiung, Taiwan 80103
Republic of China
Tel: 886(7)291-7270

Taichung Taichung Church
115 Kon-Yong Rd., Central District
Taichung, Taiwan
Republic of China
Tel: 886(4)201-3356

Tainan Tainan Church
82 Min-Tsu Rd. Section 2
Tainan, Taiwan 70004
Republic of China
Tel: 886(6)221-7108/9

Taipei Taipei Church
29 Hun-cho S. Rd. Section 1
Taipei, Taiwan 10044
Republic of China
Tel: 886(2)397-2565/6
Fax: 886(2)394-4057

Thailand Thailand Church
c/o SEAEC
P.O.Box 10510
88805 Kota Kinabalu
Sabah, E. Malaysia
Tel: 60(88)239-720 or 230-327
Fax: 60(88)233-661



U.K.
Cambridge Cambridge House of Prayer

357 St. Neots Road
Dry Drayton
Cambridge CB3 8AY
England, U.K.
Tel: 44(954)211-168

Edinburg Edinburgh Church
15A East Fettes Avenue
Edinburgh EH4 1DL
Scotland, U.K.
Tel: 44(31)343-2459 or 343-1397
Fax: 44(31)332-1891

Elgin Elgin Church
Lesmurdie Road
Bishopmill, Elgin IV30 2HP
Scotland, U.K.
Tel: 44(343)540-129 or 546-056
Fax: 44(343)548-725

Leicester Leicester Church
Humberstone Road, Parry Street
Leicester
England, U.K.
Tel: 44(533)538-200

London London Church
194 Pitfield Street
London N1 5JB
England, U.K.
Tel: 44(71)739-8613 or 802-8531
Fax: 44(81)80-8911

Newcastle Newcastle Church
Boyd Street, Shieldfield
Newcastle upon Tyne NE2 1BS
England, U.K.
Tel: 44(91)232-4836

Portsmouth Portsmouth Church
114 North End Avenue
Portsmouth PO2 8NH
England, U.K.
Tel: 44(705)667-039

Sunderland Sunderland Church
Dundas Street, Monkwearmouth
Sunderland, Tyne & Wear SR 6 0AZ
England, U.K.
Tel/Fax: 44(91)567-3499

U.S.A.
Arizona True Jesus Church in Phoenix

2640 N. Dobson Road
Chandler, AZ 85224

Worship Services
Friday........................7:30 pm
Saturday...10:30 am & 1:30 pm



(602)899-1488

California True Jesus Church in El Monte
11070 Oak Street
El Monte, CA 91731
(818)442-3438

Worship Services
Friday........................8:00 pm
Saturday...11:00 am & 1:30 pm

True Jesus Church in Garden Grove
11236 Dale Street
Garden Grove, CA 92641
(714)539-0480

Worship Services
Tuesday.....................7:30 pm
Friday........................7:30 pm
Saturday...11:00 am & 1:30 pm

Irvine House of Prayer
1492 StaFe Drive
Tustin, CA 92680
c/o 12 Del Sonota, Irvine, CA 92714

Worship Services
Saturday...11:00 am & 1:15 pm

Los Angeles House of Prayer
222 No. Saint Andrew Place
Los Angeles, CA 90004
(213)462-8986

Worship Services
Tuesday....................8:00 pm
Friday.......................8:00 pm
Saturday..11:00 am & 1:30 pm

True Jesus Church in Pacifica
P.O.Box 1776
610 Edgemar Avenue
Pacifica, CA 94044
(415)359-7183

Worship Services
Wednesday...............8:00 pm
Friday.......................8:00 pm
Saturday..10:00 am & 1:00 pm

True Jesus Church in San Jose
P.O.Box 486
521 N. 5th Street
San Jose, CA 95103
(408)286-9876

Worship Services
Tuesday....................8:00 pm
Friday.......................8:00 pm
Saturday..................10:00 am

Hawaii True Jesus Church in Honolulu
1387 Makaikoa Street
Honolulu, HI 96821
(808)734-6256

Worship Services
Wednesday...............7:30 pm
Friday.......................7:30 pm
Saturday..................10:30 am

Maui House of Prayer
525 S. Kamehameha Avenue
Kahului, Maui, HI 96732

Worship Services
Saturday.................10:30 am

Illinois Chicago House of Prayer
111 West Henry Street
Arlington Hts, IL 60004
(708)259-8014

Worship Services
Wednesday...............7:30 pm
Friday.......................7:30 pm
Saturday..11:30 am & 2:00 pm

New Jersey True Jesus Church in Elizabeth
335 Elmora Avenue
Elizabeth, NJ 07208
(908)352-7990

Worship Services
Friday.......................8:00 pm
Saturday..10:45 am & 1:30 pm

New York True Jesus Church in Queens
P.O.Box 239
96-02 95th Avenue
Ozone Park, NY 11416
(718)845-5813

Worship Services
Wednesday...............8:00 pm
Friday.......................8:00 pm
Saturday..10:30 am & 1:30 pm

Pennsylvania True Jesus Church in Philadelphia
300 W. Woodland Avenue

Worship Services
Wednesday...............8:00 pm



Springfield, PA 19064
(215)544-3766

Friday.......................8:00 pm
Saturday..10:00 am & 1:00 pm

Texas True Jesus Church in Dallas
10205 Chisholm Trail
Dallas, TX 75243
(214)437-5628

Worship Services
Friday.......................8:00 pm
Saturday..11:00 am & 1:30 pm

True Jesus Church in Houston
6126 Thomas Road
Houston, TX 77043
(713)896-1602

Worship Services
Friday.......................8:00 pm
Saturday..11:00 am & 2:00 pm



Bible Studying
The MindFrame Windows Application is also useful in several areas of Holy Bible studies. The original 
text of this ".hlp" file is available as a PostScript file (biblnote.ps) included in the release archive. You can 
get a better hardcopy from this separate PostScript file, because it preserves the better formating of the 
original document.

The Holy Bible, consisting of the Old and New Testaments, is given by inspiration of God and is the sole 
foundation of truth and the standard of faith for the believers. (2 Timothy 3:16; 2 Peter 1:21; Galations 1:6-
9). Although the Holy Bible was written by closed to 40 co-authors in a duration span over 1500 years 
(from ~1440 B.C. to ~100 A.D.) and the Old Testament (39 books, ~27) was written in Hebrew while the 
New Testament (27 books, 10 co-authors) was written in Greek, the entire Bible is extremely consistent.

There are large selection of English versions of the Holy Bible that can be found in Christian book stores 
or distributors throughout the United States (e.g. Christian Book Distributors at 508-977-5000). The most 
popular ones are:

The New International Version (NIV): It is a completely new translation of the Holy Bible directly from 
the best available Hebrew, Aramaic and Greek texts. The language is more contemporary comparing 
with other versions.
The New Revised Standard Version (NRSV): This recently released version is also well known and 
more scholarly than others.
The New King James Version (NKJV): A newly revised version of the King James Version (KJV), 
which was the oldest English translation of the Holy Bible still in use today that appeared in 1611 
under the patronage of James I. Because of its early inception, the English language used is quite 
different from contemporary English.
The New American Standard Version (NAS): Published in 1971, this is a newly revised version of the 
American Standard Version published in 1901.

Using MindFrame application to study the following categories of Bible knowledge will help you gaining 
deeper insight of the words of God. However, the best way to understand the words of God is to read the 
the Bible under the guidance of the Holy Spirit, who comes from God to guide us into all truth (John 
16:13). As the Lord Jesus promised, "If anyone loves, he will obey my teaching. My Father will love him, 
and we will come to him and make our home with him. ... But the counselor, the Holy Spirit, whom the 
Father will send in my name, will teach you all things and will remind you of everything I have said to 
you." (John 14:23, 26).

Metaphors are widely found in the Bible in which familiar figures are used to speak of other less 
familiar concept.

Types are frequently found in the Old Testament which prefigure things to come in the New 
Testament, where one finds anti-types, the counterpart of types.

Messianic Prophecies are widely found in the books of the Old Testament that foretold the coming
of a Messiah as the one and only Savior of the world, and later fulfilled in the New Testament in 
the ministry of the Lord Jesus Christ, who is the God manifested in the flesh.

End-Time Prophecies are found in both the Old and the New Testaments that foretold the return 
of our Lord Jesus Christ to judge the world, to destroy heavens and earth, to create new heavens 
and a new earth, and to reveal the glory of the Holy City, the new Jerusalem.

Jesus' Parables are short tales that uses earthly things as analogy to convey spiritual meaning to 
the hearer. To understand a parable, you should pay attention to mportant features, and yet not 
make all details mean something.



See also
Bible Studying Samples



Metaphors
Metaphors are widely found in the Bible where familiar figures are used to speak of other less familiar 
concepts. Both the familiar and the unfamiliar concepts can be represented as object models with classes
and relationships among them. To understand a metaphor, in the mind of a hearer, the object model of the
familiar concept is mapped to the unfamiliar one. There are countless metaphors found in the Bible, we 
only provide a small sample as examples, in the hope of helping you get started on your exploration. You 
can find the following examples as working samples distributed with the release archive. A number of 
additional metaphors used by the Lord Jesus Christ are also listed at the end. You can use them to 
practice using the MindFrame as a bible-studying tool.

Yoke and Burden
28"Come to me, all you who are weary and burdened, and I will give you rest. 29Take my yoke upon you 
and learn from me, for I am gentle and humble in heart, and you will find rest for your souls. 30For my 
yoke is easy and my burden is light." (Matthew 11:28-30, Ref. Isaiah 9:4, Psalm 2:3, 1 King 12:4)

See also
Metaphor Modeling Samples

The Shepherd
1The Lord is my shepherd, I shall not be in want. 2He makes me lie down in green pastures, he leads me 
beside quiet waters, 3he restores my soul. He guides me in paths of righteousness for his name's sake. 
4Even though I walk through the valley of the shadow of death, I will fear no evil, for you are with me; your
rod and your staff they comfort me. 5You prepare a table before me in the presence of my enemies. You 
anoint my head with oil; my cup overflows. 6Surely goodness and love will follow me all the days of my 
life, and I will dwell in the house of the Lord forever.(Psalm 23:1-6)

He tends his flock like a shepherd: He gathers the lambs in his arms and carries them close to his heart; 
he gently leads those that have young. (Isaiah 40:11)

Hen and Chicks
37Jesus said, "O Jerusalem, Jerusalem, you who kill the prophets and stone those send to you, how often
I have longed to gather your children together, as a hen gathers her chicks under her wings, but you were
not willing. 38Look, your house is left to you desolate. 39For I tell you, you will not see me again until you 
say, `Blessed is he who comes in the name of the Lord.`" (Matthew 23:37-39; Luke 13:34-35)

See also
Metaphor Modeling Samples

The True Vine
"1I am the true vine and my Father is the gardener. 2He cuts off every branch in me that bears no fruit, 
while every branch that does bear fruit he prunes so that it will be even more fruitful. 3You are already 
clean because of the word I have spoken to you. 4Remain in me, and I will remain in you. No branch can 
bear fruit by itself; it must remain in the vine. Neither can you bear fruit unless you remain in me.
5I am the vine; you are the branches. If a man remains in me and I in him, he will bear much fruit; apart 
from me you can do nothing. 6If anyone does not remain in me, he is like a branch that is thrown away 
and withers; such branches are picked up, thrown into the fire and burned. 7If you remain in me and my 
words remain in you, ask whatever you wish, and it will be given you. 8This is to my Father's glory, that 
you bear much fruit, showing yourselves to be my disciples.
9As the Father has loved me, so have I loved you. Now remain in my love. 10If you obey my commands, 
you will remain in my love, just as I have obeyed my Father's commands and remain in his love. 11I have 
told you this so that my joy may be in you and that your joy may be complete. 12My command is this: 
Love each other as I have loved you. 13Greater love has no one than this, that he lay down his life for his 



friends. 14You are my friends if you do what I command. 15I no longer call you servants, because a 
servant does not know his master's business. Instead, I have called you friends, for everything I have 
made known to you. 16You did not choose me, but I chose you and appointed you to go and bear fruitfruit 
that will last. Then the Father will give you whatever you ask in my name. 17This is my command: Love 
each other.(John 15:1-17)

See also
Metaphor Modeling Samples

The Grafted Branches
16if the part of the dough offered as first fruits is holy, then the whole batch is holy; if the root is holy, so 
are the branches. 
17If some of the branches have been broken off, and you, though a wild olive shoot, have been grafted in 
among the others and now share in the nourishing sap from the olive root, 18do not boast over the 
branches. If you do, consider this: You do not support the root, but the root supports you. 19You will say 
then, "Branches were broken off so that I could be grafted in." 20Granted. But they were broken off 
because of unbelief, and you stand by faith. Do not be arrogant, but be afraid. 21For if God did not spare 
the natural branches, he will not spare you either.
22Consider therefore the kindness and sternness of God: sternness to those who fell, but kindness to you,
provided that you continue in His kindness. Otherwise, you also will be cut off. 23And if they do not persist
in unbelief, they will be grafted in, for God is able to graft them in again. 24After all, if you were cut out of 
an olive tree that is wild by nature, and contrary to nature were grafted into a cultivated olive tree, how 
much more readily will these, the natural branches, be grafted into their own olive tree. (Romans 11:16-
24)

Tree with Fruit
8"Produce fruit in keeping with repentance ...9The ax is already at the root of the trees, and every tree that
does not produce good fruit will be cut down and thrown into the fire."(Luke 3:8-9)
"I preached that they should repent and turn to God and prove their repentance by their deeds." (Acts 
26:20)

22But the fruit of the spirit is love, joy, peace, patience, kindness, goodness, faithfulness, 23gentleness 
and self-control. Against such things there is no law. (Galatians 5:22-23)

Wheat and Chafff
His winnowing fork is in his hand to clear his threshing floor and to gather the wheat into his barn, but he 
will burn up the chaff with unquenchable fire. (Luke 3:17)

Heavens and Earth
8For my thoughts are not your thoughts, neither are your ways my ways, declares the Lord. 9As the 
heavens are higher than the earth, so are my ways higher than your ways and my thoughts than your 
thoughts. 10As the rain and the snow come down from heaven, and do not return to it without    watering 
the earth and making it bud and flourish, so that it yields seed for the sower and bread for the eater, 11so 
is my word that goes out from my mouth: it will not return to me empty, but will accomplish what I desire 
and achieve the purpose for which I sent it. (Isaiah 55:8-11)

The Armor of God
10Finally, be strong in the Lord and in his mighty power. 11Put on the full armor of God so that you can 
take your stand against the devil's schemes. 12For our struggle is not against flesh and blood, but against 
the rulers, against the authorities, against the powers of this dark world and against the spiritual forces of 
evil in the heavenly realms. 13Therefore put on the full armor of God, so that when the day of evil comes, 
you may be able to stand your ground, and after you have done everything, to stand. 14Stand firm then, 
with the belt of truth buckled around your waist, with the breastplate of righteousness in place, 15and with 
your feet fitted with the readiness that comes from the gospel of peace. 16In addition to all this, take up 
the shield of faith, with which you can extinguish all the flaming arrows of the evil one. 17Take the helmet 



of salvation and the sword of the Spirit, which is the word of God. (Ephesians 6:10-17)

Some Metaphors Used by the Lord Jesus Chirst
To help you practice using MindFrame as a tool in your Bible study, try analyzing the following metaphors.

Salt (Matthew 5:13)
Light (Matthew 5:14-16)
Treasures in Heaven (Matthew 6:19-21)
The eye is the lamp of the body (Matthew 6:33-23)
The narrow and wide gate (Matthew 7:13)
A tree and its fruit (Matthew 7:15-20)
The wise and foolish builder (Matthew 7:24-27)
The guests and the bridegroom (Matthew 7:15)
The patch on an old garment (Matthew 7:16)
New wine into old wineskins (Matthew 7:17)
The harvest and the workers (Matthew 9:37-38)
The yeast of the Pharisees and Sadducees (Matthew 16:4)



Types and Anti-types
There are several meanings associated with the the Greek word tupos used in the New Testament, such 
as figure, pattern, example, ensample, etc. In the bible, the Old Testament contains many "types". A type 
is a representation of something to come, an event in the Old Testament that foreshadows another in the 
New Testament. The counterpart of a type is an "anti-type" in the New Testament. Therefore an "anti-type"
is foreshadowed by or identified with an earlier symbol or type in the Old Testament.

See also
Bible Types/Anti-types Samples

Type Anti-type
By faith the people passed through the Red 
Sea as on dry land; but when the Egyptians 
tried to do so, they were drowned. (Hebrews 
11:29)

1For I do not want you to be ignorant of the 
fact, brothers, that our forefathers were all 
under the cloud and that they all passed 
through the sea. 2They were all baptized into 
Moses in the cloud and in the sea. (1 
Corinthians 10:1-2)

Jesus said, 49" I have come to bring fire on the
earth, and how I wish it were already kindled! 
50But I have a baptism to undergo, and how 
distressed I am until it is completed. (Luke 
12:49-50)

"I baptize you with water for repentance. But 
after me will come one who is more powerful 
than I, whose sandles I am not fit to carry. He 
will baptize you with the Holy Spirit and with 
fire." (Matthew 3:11)

13Then Jesus came from Galilee to the Jordan
to be baptized by John. 14But John tried to 
deter him, saying, "I need to be baptized by 
you, and do you come to me?"
15Jesus replied, "Let it be so now; it is proper 
for us ti do this to fulfill all righteousness." Then
John consented.
16As soon as Jesus was baptized, he went up 
out of the water. At that moment heaven was 
opened, and he saw the Spirit of God 
descending like a dove and lighting on him. 
17And a voice from heaven said, "This is my 
son, whom I love; with him I am well pleased." 
(Matthew 3:13-17)

38Peter replied, "Repent and be baptized, 
every one of you, in the name of Jesus Christ 
for the forgiveness of your sins. And you will 
receive the gifts of the Holy Spirit. 39The 
promise is for you and your children and for all 
who are far offfor all whom the Lord our God 
will call." (Acts 2:38-39)

1What shall we say, then? Shall we go on 
sinning so that grace may increase? 2By no 
means! we died to sin; how can we live it any 
longer? 3Or don't you know that all of us who 
were baptized into Christ Jesus were baptized 
into his death? 4We were therefore buried with 
him through baptism into death in order that, 



just as Christ was raised from the dead through
the glory of the Father, we too may live a new 
life. (Romans 6:1-4)

The Lord said to Moses and Aaron: "...`... 
33Your children will be shepherds here for forty
years, suffering for your unfaithfulness, until 
the last of your bodies lies in the desert. 34For 
forty yearsone year for each of the forty days 
you exlored the landyou will suffer for your sins
and know what it is like to have me against 
you` 35I, the Lord, have spoken, and I will 
surely do these things to this whole wicked 
community, which has banded together against
me. They will meet their end in this desert; 
here they will die." (Numbers 14:33-35)

1For I do not want you to be ignorant of the 
fact, brothers, that our forefathers were all 
under the cloud and that they all passed 
through the sea. 2There were all baptized into 
Moses in the cloud and in the sea. 3They all 
ate the same spiritual food 4and drank the 
same spiritual drink; for they drank from the 
spiritual rock that accompanied them, and that 
rock was Chirst. 5Nevertheless, God was not 
pleased with most of them; their bodies were 
scattered over the desert. (1 Corinthians 10:1-
5)

1Then Jesus was led by the Spirit into the 
desert to be tempted by the devil. 2After fasting
forty days and forty nights, he was hungry. 
3The tempter came to him and said, "If you are
the Son of God, tell these stones to become 
bread."
4Jesus answered, "It is written: `Man does not 
live on bread alone, but one every word that 
comes fromthe mouth of God.`"
5Then the devil took him to the holy city and 
had him stand on the highest point of the 
temple. 6"If you are the Son of God," he said, 
"throw yourself down, For it is written: "`He will 
command his angels concerning you, and they 
will lift you up in their hands, so that you will 
not strike your foot against a stone.`"
7Jesus answered him, "It is also written: `Do 
not put the Lord your God to the test.`"
8Again, the devil took him to a very high 
mountain and showed him all the kingdoms of 
the world and their splendor. 9"All this I will 
give you," he said, "if you will bow down and 
worship me."
10Jesus said to him, "Away from me, Satan! 
For it is written: `Worship the Lord your God, 
and serve him only.`"
11Then the devil left him, and angels came and
attended him. (Matthew 1-11; Mark 1:12-13; 
Luke 3:1-13)
36He (Moses) led them out of Egypt and did 
wonders and miraculous signs in Egypt, at the 
Red Sea and for forty years in the desert. (Acts
7:36)
17The God of the people of Israel chose our 
fathers; he made the people prosper during 
their stay in Egypt, with mighty power he led 
them out of that country, 18he endured their 
conduct for about forty years in the desert, 
19he overthrew seven nations in Canaan and 
gave their land to his people as their 
inheritance. All this took about 450 years. (Acts
13:17-19)

1While Israel was staying in Shittim, the men 
began to indulge in sexual immorality with 
Moabite women, 2who invited them to the 
sacrifices to their gods. ... And the Lord's anger
burned against them. (Numbers 25:1-9)

8We should not commit sexual immorality, as 
some of them were; as some of them didand in
one day twenty-three thousand of them died. (1
Corinthians 10:8)

(Eastern tribes return home...) 1Then Joshua 
summoned the Reubenites, the Gadites and 

8For if Joshua had given them rest, God would
not have spoken later about another day. 



the half-tribe of Manasseh 2and said to them, 
"You have done all that Moses the servant of 
the Lord commanded, and you have obeyed 
me in everything I commanded. 3For a long 
time nowto this very dayyou have not deserted 
your brothers but have carried out the mission 
the Lord your God gave you. 4Now that the 
Lord your God has given your brothers rest as 
he promoised, return to your homes in the land
that Moses the servant of the Lord gave you on
the other side of the Jordan. 5But be very 
careful to keep the commandment and the law 
that Moses the servant of the Lord gave you: to
love the Lord your God, to walk in all His ways,
to obey his commands, to hold fast to him and 
to serve him with all your heart and all your 
soul." (Joshua 22:1-5)

9There remains, then, a Sabbath-rest for the 
people of God; 10for anyone who enters God's
rest also rests from his own work, just as God 
did from his. 11Let us, therefore, make every 
effort yo enter that rest, so that no one will fall 
by following their example of disobedience.
12For the workd of God is living and active. 
Sharper than any double-edged sword, it 
prnetrates even to dividing soul and spirit, 
joints and marrow; it judges the thoughts and 
attitudes of the heart. 13Nothing in all creation 
is hidden from God's sight. Everything is 
uncovered and laid bare before the eyes of him
to whom we must give account. (Hebrew 4:8-
13)

But the Lord provided a great fish to swallow 
Jonah, and Jonah was inside the fish three 
days and three nights. (Jonah 1:17)

39"A wicked and adulterous generation asks 
for a miraculous sign! But none will be given it 
except the sign of the prophet Jonah. 40For as 
Jonah was three days and three nights in the 
belly of a huge fish, so the Son of Man will be 
three days and three nights in the heart of the 
earth. (Matthew 12:39-40)

8The Lord said to Moses, "Make a snake and 
put it up on a pole; anyone who is bitten can 
look at it and live", 9So Moses made a bronze 
snake and put it up on a pole. Then when 
anyone was bitten by a snake and looked at 
the bronze snake, he lived. (Numbers 21:8-9)

13"No one has ever gone into heaven except 
the one who came from heaventhe Son of 
Man. 14Just as Moses lifted up the snake in 
the desert, so the Son of Man must be lifted 
up, 15that everyone who believes in him may 
have eternal life" (John 3:13-15)

Moses then took the blood, sprinkled it on the 
people and said," This is the blood of the 
covenant that the Lord has made with you in 
accordance with all these words." (Exodus 
24:8)
As for you, because of the blood of my 
covenant with you, I will free your prisoners 
from the waterless pit. (Zechariah 9:11)

28"This is My blood of the New Covenant, 
which is poured out for many for the 
forgiveness of sins. 29I tell you, I will not drink 
of this fruit of the vine from now on until that 
day when I drink it anew with you in my 
Father's kingdom." (Matthew 26:28-29)

5The animals you choose must be year-old 
males without defect, and you may take them 
from the sheep or the goats, 6take care of 
them until the fourteenth day of the month, 
when all the people of the community of Israel 
must slaughter them at twilight. 7Then they are
to take some of the blood and put it on the 
sides and tops of the door frames of the 
houses where they eat the lambs. 8That same 
night they are to eat the meat roasted over the 
fire, along with bitter herbs, and bread made 
without yeast. 9Do not eat the meat raw or 

On the first day of the Feast of Unleavened 
Bread, when it was customary to sacrifice the 
Passover lamb, Jesus' disciples asked him, 
"Where do you want us to go and make 
preparations for you to eat the Passover?" 
(Mark 14:12)
But when they came to Jesus and found that 
he was already dead, they did not break his 
legs. Instead, one of the soldiers pierced 
Jesus' side with a spear, bringing a sudden 
flow of blood and water. (John 19:34)
6Don't you know that a little yeast works 



cooked in water, but roast it over the firehead, 
legs and inner parts. 10Do not leave any of it 
till morning; if some is left till morning, you 
must burn it. 11The is how you are to eat it: 
with your cloak tucked into your belt, your 
sandals on your feet and your staff in your 
hand. Eat it in haste; it is the Lord's Passover. 
(Exodus 12:5-11)
43The Lord said to Moses and Aaron, "These 
are the regulations for the Passover: "...46It 
must be eaten inside one house; take none of 
the meat outside the house. Do not break any 
of the bones. 47The whole community of Israel
must celebrate it...." 50All the Israelites did just
what the Lord had commanded Moses and 
Aaron. 51And on that very day the Lord 
brought the Israelites out of Egypt by their 
divisions. (Exodus 12:43-51)

through the whole batch of dough? 7Get rid of 
the old yeastas you really are. For Christ, our 
Passover lamb, has been sacrificed. 
8Therefore let us keep the Festival, not with 
the old yeast, the yeast of malice and 
wickedness, but with bread without yeast, the 
bread of sincerity and truth. (1 Corinthians 5:6-
8)
18For you know that it was not with perishable 
things such as silver or gold that you were 
redeemed from the empty way of life handed 
down to you from your forefathers, 19but with 
the precious blood of Christ, a lamb without 
blemish or defect. 20He was chosen before the
creation of world, but was revealed in these 
last times for your sake. 21Through him you 
believe in God. Who raised him from the dead 
and glorified him, and so your faith and hope 
are in God. (1 Peter 1:18-21)

Old Testament Messianic Prophecies Fulfilled in Jesus Christ
Messianic prophecies are widely found in the books of the Old Testament that foretold the coming of a 
Messiah as the one and only Savior of the world, and later fulfilled in the ministry of the Lord Jesus Christ,
who is the God manifested in the flesh. We have only listed the verses found mainly in the four Gospels of
the New Testament. There are many other similar verses pointed out by the apostles in their epistles to 
the churches (e.g. Romans, Hebrews, etc.). Try finding them and practice using MindFrame to construct 
object models for them.

See also
Messianic Prophecy Samples

Old Testament Prophecy New Testament Fulfillment
The virgin will be with child and will give birth to
a son, and they will call him Immanuel. (Isaiah 
7:14)

The birth of Jesus Christ (Matthew 1:18-21)

But you, Bethlehem, in the land of Judah, are 
by no means least among the rulers of Judah; 
for out of you will come a ruler who will be the 
shepherd of my people Israel. (Micah 5:2)

After Jesus was born in Bethlehem in Judea, 
during the time of King Herod, Magi from the 
east came to Jerusalem and asked... (Matthew
2:1)

Out of Egypt I called my son. (Hosea 11:1) The escape to Egypt (Matthew 2:13-15)

A voice is heard in Ramah, weeping and great 
mourning,    Rachel weeping for her children 
and refusing to be comforted because they are
no more. (Jeremiah 31:15)

When Herod realized that he had been 
outwitted by the Magi, he was furious, and he 
gave orders to kill al the boys in Bethlehem 
and its vicinity who were two years old and 
under, in accordance with the time he had 
learned from the Magi. (Matthew 2:16)



He will be called a Nazarene ("despised") 
(Psalm 22:6; Isaiah 53:3; Isaiah 11:1)

and he went and returned to a town called 
Nazareth. So was fulfilled what was said 
through the prophets: "He will be called a 
Nazarene." (Matthew 2:23; Luke 3)

3A voice of one calling in the desert, `Prepare 
the way for the Lord, make straight paths for 
him. 4Every valley should be filled in, every 
mountain and hill made low. The crooked 
roads shall become straight, the rough ways 
smooth.5And the glory of the Lord will be 
revealed, and all mankind together will see it. 
For the mouth of the Lord has spoken.' (Isaiah 
40:3-5)

In those days John the Baptist came, 
preaching in the Desert of Judea and saying, 
"Repent, for the kingdom of heaven is near." 
This is he who was spoken of through the 
prophet Isaiah: ... (Matthew 3:1-3; Mark 1:3; 
John 1:23)

He said to me, "You are my Son; today I have 
become your Father.." (Psalm 2:7)
"Here is my servant, whom I uphold, my 
chosen one in whom I delight; I will put my 
Spirit on him and he will bring justice to the 
nations. He will not quarrel or cry out; no one 
will hear his voice in the streets. A bruised reed
he will not break, and a smoldering wick he will
not snuff out, till he leads justice to victory. In 
his name the nations will put their hope." 
(Isaiah 42:1-4)

And a voice from heaven said, "This is my Son,
whom I love; with him I am well pleased" 
(Matthew 3:17)
God's chosen servant (Matthew 12:15-21)

1Nevertheless, there will be no more gloom, for
those who were in distress. In the past he 
humbled the land of Zebulun and the land of 
Naphtali, but in the future he will honor Galilee 
of the Gentiles, by the way of the sea, along 
the Jordan2the people walking in darkness 
have seen a great light; on those living in the 
land of the shadow of death a light has 
dawned" (Isaiah 9:1-2)

12When Jesus heard that John had been put in
prison, he returned to Galilee. 13Leaving 
Nazareth, he went and lived in Capernaum, 
which was by the lake in the area of Zebulun 
and Naphtali. (Matthew 4:12-13)

1The Spirit of the Lord is on me, because he 
has anointed me to preach good news to the 
poor. He has sent me to proclaim freedom for 
the prisoners and recovery of sight for the 
blind, to release the oppressed, 2to proclaim 
the year of the Lord's favor. (Isaiah 61:1-2)

16He went to Nazareth, where he had been 
brought up, and on the Sabbath day he went 
into the synagogue, as was his custom. And he
stood up to read. 17The scroll of the prophet 
Isaiah was handed to him. Unrolling it, he 
found the place where it is written: C"The Spirit 
of the Lord is on me, ..." 20Then he rolled up 
the scroll, gave it back to the attendant and sat 
down. The eyes of everyone in the synagogue 
were fastened on him, 21and he began by 
saying to them, "Today this scripture is fulfilled 
in your hearing." (Luke 4:16-21)



He took up our infirmities, and carried our 
diseases. (Isaiah 53:4)

Jesus heals many (Matthew 8:14-16)

I desire mercy, not sacrifice (Hosea 6:6) 12Jesus said, "It is not the healthy who need a 
doctor, but the sick. 13But go and learn what 
this means: `I desire mercy, not sacrifice.` For I
have not come to call the righteous, but 
sinners" (Matthew 9:12-13)
Lord of the Sabbath (Matthew 12:3-8)

A man against his father, a daughter against 
her mother, a daughter-in-law against her 
mother-in-lawa man's enemies will be the 
members of his own household. (Micah 7:6)

34Jesus said, "Do not suppose that I have 
come to bring peace to the earth. I did not 
come to bring peace, but a sword. 35For I have
come to turn `a man against ...` (Matthew 
10:34-36)

I will send my messenger ahead of you, who 
will prepare your way before you. (Malachi 3:1)

Jesus said, "..Then what did you go out to 
see? A prophet? Yes, I tell you, and more than 
a prophet. This is the one about whom it is 
written: ... (Matthew 11:9-10; Mark 1:2)

Though seeing, they do not see; though 
hearing, they do not hear or understand. 
(Deuteronomy 29:4)
"Lord, who has believed our message and to 
whom has the arm of the Lord been revealed?"
(Isaiah 53:1)
You will be ever hearing but never 
understanding; you will be ever seeing but 
never perceiving. For this people's heart has 
become calloused; they hardly hear with their 
ears, and they have closed their eyes. 
Otherwise they might see with their eyes, hear 
with their ears, understand with their hearts 
and turn, and I would heal them. (Isaiah 6:9-
10)

11Jesus replied, " The knowledge of the secrets
of the kingdom of heaven has been given to 
you, but not to them. 12Who ever has will be 
given more, and he will have an abundance. 
Whoever does not have, even what he has will 
be taken from him. 13This is why I speak to 
them in parables: "Though seeing, ..." 
(Matthew 13:11-13; Mark 4:12; Luke 8:10; John
12:40);

I will open my mouth in parables, I will utter 
things hidden since the creation of the world. 
(Psalm 78:2)

Jesus spoke all these things to the crowd in 
parables; he did not say anything to them 
without using a parable. (Matthew 13:34)

These people honor me with their lips, but their
hearts are far from me. They worship me in 
vain; their teachings are but rules taught by 
men. (Isaiah 29:13)

Pharisees came to Jesus and asked, "Why do 
your disciples break the tradition of the elders? 
They don't wash their hands before they eat!" 
Jesus replied, " And why do you break the 
command of God for the sake of your tradition?
..." (Matthew 15:1-9; Mark 7:6-7)

Say to the daughter of Zion, `See, your king 
comes to you, gentle and riding on a donkey, 

Jesus sent two disciples, 2saying to them, "Go 
to the village ahead of you, and at once you 



on a colt, the foal of donkey.` (Zechariah 9:9) will find a donkey tied there, with her colt by 
her. Untie them and bring them to me. 3If 
anyone says anything to you, tell him that the 
Lord needs them, and he will send them right 
away." 4This took place to fulfill what was 
spoken through the prophet: 5"Say to the 
daughter of Zion, ..." (Matthew 21:2-5; John 
12:15)

Blessed is he who comes in the name of the 
Lord! (Psalm 118:26)

6The disciples went and did as Jesus had 
instructed them. 7They brought the donkey and
the colt, placed their cloaks on them, and 
Jesus sat on them. 8A very large crowd spread 
their cloaks on the road, while others cut 
branches from the trees and spread them on 
the road. 9The crowds that went ahead of him 
and those that followed    shouted, "Hosanna to
the Son of David!" "Blessed is he who comes 
in the name of the Lord!" ... (Matthew 21:6-9; 
Mark 11:9; Luke 19:38; John 12:13))

`My house will be called a house of prayer for 
all nations`(Isaiah 56:7),
but you are making it a
`den of robbers.` (Jeremiah 7:11)

12Jesus entered the temple area and drove out
all who were buying and selling there. He 
overturned the tables of the money changers 
and the benches of those selling doves. 13"It is 
written," he said to them "`My house will be 
called a house of prayer`, ... (Matthew 21:12-
13; Mark 11:17; Luke 19:46)

"Zeal for your house will consume me." (Psalm
69:9)

(Jesus clears the Temple...)    16To those who 
sold doves he said, "Get these out of here! 
How dare you turn my Father's house into a 
market!"
17His disciples remembered that it is written: 
"Zeal for your house will consume me." (John 
2:16-17)

`From the lips of the children and infants you 
have ordained praise` (Psalm 8:2)

14The blind and the lame came to him at the 
temple, and he healed them. 15But when the 
chief priests and the teachers of the law saw 
the wonderful things he did and the children 
shouting in the temple area, "Hosanna to the 
Son of David," they were indignant. 16"Do you 
hear what these children are saying?" they 
asked him. "Yes," replied Jesus, "have you 
never read, `From the lips of children and 
infants you have ordained praise`?" (Matthew 
21:14-16)

They will all be taught by God. (Isaiah 54:13) 44"No one can come to me unless the Father 
who sent me draws him, and I will raise him up 
at the last day. 45It is written in the Prophets: 



`They will all be taught by God.` Everyone who 
listens to the Father and learns from him 
comes to me. 46No one has seen the Father 
except the one who is from God; only he has 
seen the Father. (John 6:44-46)

The stone the builders rejected has become 
the capstone; the Lord has done this, and it is 
marvelous in our eyes. (Psalm 118:22-23)

42Jesus said to them, "Have you never read in 
the Scriptures: `The stone the builders ...`? 
43Therefore I tell you that the kingdom of God 
will be taken away from you and given to a 
people who will produce its fruit. 44He who falls
on this stone will be broken to pieces, but he 
on whom it falls will be crushed" (Matthew 
21:42-44; Mark 12:10-11; Luke 20:17)

The Lord said to my Lord: "Sit at my right hand
until I put your enemies under your feet." 
(Psalm 110:1)

35While Jesus was teaching in the temple 
courts, he asked, "How is it that the teachers of
the law say that the Christ is the son of David? 
36David himself, speaking by the Holy Spirit, 
declared: "`The Lord said to my Lord: ..." David
calls him `Lord.` How then can he be his son?" 
(Mark 12:35-36; Luke 20:41-44)

He who shares my bread has lifted up his heel 
against me. (Psalm 41:9)

(Jesus predicts His betrayal...) I am not 
referring to all of you; I know those I have 
chosen. But this is to fulfill the scripture: `He 
who shares my bread has lifted up his heel 
against me.` (John 12:18)

They hated me without reason. (Psalm 35:19; 
69:4)

23He who hates me, hates my Father as well. 
24If I had not done among    them what no one 
else did, they would not be guilty of sin. But 
now they have seen these miracles, and yet 
they have hated both me and my Father. 25But 
this is to fulfill what is written in their Law: 
`They hated me without reason.` (John 15:23-
25)

I will strike the shepherd, and the sheep of the 
flock will be scattered. (Zechariah 13:7)

31Then Jesus told them, "This very night you 
will fall away on account of me, for it is written: 
"I will strike the ...` 32But after I have risen, I 
will go ahead of you into Galilee." (Matthew 
26:31-32; Mark 14:27)

They took the thirty silver coins, the price set 
on him by the people of Israel, and they used 
them to buy the potter's field, as the Lord 
commanded me. (Zechariah 11:12-13; 
Jeremiah 19:1-13, 32:6-9)

14Then one of the Twelvethe one called Judas 
Iscariotwent to the chief priests 15and asked, 
"What are you willing to give me if I hand him 
over to you? So they counted out for him thirty 
silver coins. (Matthew 26:14-15)
6The chief priests picked up the coins and said,
"It is against the law to put this into the 



treasury, since it is blood money." 7So they 
decided to use the money to buy the potter's 
field as a burial place for foreigners. 8That is 
why it has been called Field of Blood to this 
day. 9Then what was spoken by Jeremiah the 
prophet was fulfilled: "They took the thirty    
silver coins ..." (Matthew 27:6-10)

He was numbered with the transgressors. 
(Isaiah 53:12)
He was counted with the lawless one. (Isaiah 
53:12)

(After the last supper...)    36He said to them, 
"But now if you have a purse, take it , and also 
a bag; and if you don't have a sword, sell your 
cloak and buy one. 37It is written: `And he was 
numbered with the transgressors`; and I tell 
you that this must be fulfilled in me. Yes, what 
is written about me is reaching its fulfillment" 
(Luke 22:36-37)
27They crucified two robbers with him, one on 
his right and one on his left, 28and the scripture
was fulfilled which says, "He was counted with 
the ..." (Mark 15:27-28)

They will say to the mountains, "Fall on us!" 
and to the hills, "Cover us! (Hosea 10:8)

(on His way to be crucified...) 28Jesus turned 
and said to them, "Daughters of Jerusalem, do 
not weep for me; weep for yourselves and for 
your children. 29For the time will come when 
you will say, Blessed are the barren women, 
the wombs that never bore and the breasts that
never nursed! 30Then "`They will say to the 
mountains, ..." 31For if men do these things 
when the tree is green, what will happen when 
it is dry?" (Luke 23:28-31)
(Fulfilled in A.D. 70 when Romans destroyed 
Jerusalem)

16Dogs have surrounded me; a band of evil 
men has encircled me, they have pierced my 
hands and my feet. 17I can count all my bones;
people stare and gloat over me. 18They divided
my garments among them and cast lots for my 
clothing. (Psalm 22:16-18)

When they had crucified him, they divided up 
his clothes by casting lots. (Matthew 27:35; 
Mark 15:24; Luke 23:34; John 19:24)

Not one of his bones will be broken. (Exodus 
12:46; Numbers 9:12; Psalm 34:20)
They will look on the one they have pierced. 
(Zechariah 12:10)

31Now it was the day of Preparation, and the 
next day was to be a special Sabbath. 
Because the Jews did not want the bodies left 
on the crosses during the Sabbath, they asked 
Pilate to have the legs broken and the bodies 
taken down. 32The soldiers therefore came 
and broke the legs of the first man who had 
been crucified with Jesus, and then those of 
the other. 33But when they came to Jesus and 
found that he was already dead, they did not 
break his legs. 34Instead, one of the soldiers 
pierced Jesus' side with a spear, bringing a 



sudden flow of blood and water. 35The man 
who saw it has given testimony, and his 
testimony is true. He knows that he tells the 
truth, and he testifies so that you also may 
believe. 36These things happened so that the 
scripture would be fulfilled: "Not one of his 
bones will be broken," 37and, as another 
scripture says, "They will look on the one they 
have pierced." (John 19:31:37)

My God, my God, why have you forsaken me? 
(Psalm 22:1)

45From the sixth hour until the ninth hour 
darkness came over all the land. 46About the 
ninth hour Jesus cried out in a loud voice, 
"Eloi, Eloi, lama sabachthani?"which means, 
"My God, my God, why have you forsaken 
me?" (Matthew 27:45-46; Mark 15:33-34)

The Lord said to the serpent, "...And I will put 
enmity between you and the woman, and 
between your offspring and hers; he will crush 
your head, and you will strike his heel." 
(Genesis 3:15)
8The Lord said to Moses, "Make a snake and 
put it up on a pole; anyone who is bitten can 
look at it and live." 9So Moses made a bronze 
snake and put it up on a pole. Then when 
anyone was bitten by a snake and looked at 
the bronze snake, he lived. (Numbers 21:8-9)
The Lord your God will raise up for you a 
prophet like me from among your own 
brothers. You must listen to him. (Deuteronomy
18:15)
The virgin will be with child and will give birth to
a son, and they will call him Immanuel. (Isaiah 
7:14)
For onto us a child is born, to us a son is given,
and the government will be on his shoulders. 
And he will be called Wonderful Counselor, 
Mighty God, Everlasting Father, Prince of 
Peace. (Isaiah 9:6)
10See, the sovereign Lord comes with power, 
and his arm rules for him. See, his reward is 
with him, and his recompense accompanies 
him. 11He tends his flock like a shepherd: He 
gathers the lambs in his arms and carries them
close to his heart; he gently leads those that 
have young. (Isaiah 40:10-11)
...5But he was pierced for our transgressions, 
he was crushed for our inequities; the 
punishment that brought us peace was upon 
him, and by his wounds we are healed. 6We 
all, like sheep, have gone astray, each of us 

(After Jesus was resurrected, He appeared to 
two disciples on the road to Emmaus...) 25He 
said to them, "How foolish you are, and how 
slow of heart to believe all that the prophets 
have spoken! 26Did not the Christ have to 
suffer these things and then enter his glory?" 
27And beginning with Moses and all the 
Prophets, he explained to them what was said 
in all the Scriptures concerning himself. (Luke 
24:25-27)



has turned to his own way; and the Lord has 
laid on him the iniquity of us all. ...(Isaiah 53)
23I will place over them one shepherd, my 
servant David, and he will tend them; he will 
tend them and be their shepherd. 24I the Lord 
will be their God, and my servant David will be 
prince among them. I the Lord have spoken. 
(Ezekiel 34:23-24)
seventy `sevens` are decreed for your people 
and your holy city to finish transgression, to put
an end to sin, to atone for wickedness, to bring
in ever-lasting righteousness, to seal up vision 
and prophecy and to anoint the most holy. 
(Daniel 9:24)
You will be true to Jacob, and show mercy to 
Abraham, as you pledged on oath to our 
fathers in days long ago. (Micah 7:20)
"See, I will send my messenger, who will 
prepare the way before me. Then suddenly the
Lord you are seeking will come to his temple; 
the messenger of the covenant, whom you 
desire, will come," says the Lord Almighty. 
(Malachi 3:1)

...7 I will proclaim the decree of the Lord: He 
said to me, "You are my Son; today I have 
become your Father. 8Ask of me, and I will 
make the nations your inheritance, the ends of 
the earth your possession. 9You will rule them 
with an iron scepter; you will dash them to 
pieces like pottery..    .12..Blessed are all who 
take refuge in him. (Psalm 2)
...8I have set the Lord always before me. 
Because he is at my right hand, I will not be 
shaken. 9 Therefore my heart is glad and my 
tongue rejoices; my body also will rest secure, 
10because you will not abandon me to the 
grave, nor will you let your Holy One see 
decay. 11You have made known to me the path
of life; you will fill me with joy in your presence,
with eternal pleasures at your right hand. 
(Psalm 16)
1My God, my God, why have you forsaken 
me? Why are you so far from saving me, so far
from the words of my groaning? 2O my God, I 
cry out by day, but you do not answer, by night,
and am not silent. ...6But I am a worm and not 
a man, scorned by men and despised by the 
people. 7All who see me mock me; they hurl 
insults, shaking their heads: 8"He trusts in the 
Lord; let the Lord rescue him, since he delights
in him." ...14I am poured out like water, and all 
my bones are out of joint. My heart has turned 
to wax; it has melted away within me. 15My 

(Later Jesus appears to the disciples in 
Jerusalem ...) 36While they were still talking 
about this, Jesus himself stood among them 
and said to them, "Peace be with you." 37They 
were startled and frightened, thinking they saw 
a ghost. 38He said to them, "Why are you 
troubled , and why do doubts rise in your 
mind? 39Look at my hands and my feet. It is I 
myself! Touch me and see; a ghost does not 
have flesh and bones, as you see I have."
40When he had said this, he showed them his 
hands and feet. 41And while they still did not 
believe it because of joy and amazement, he 
asked them, "Do you have anything here to 
eat?" 42They gave him a piece of broiled fish, 
43and he took it and ate it in their presence.
44He said to them, "This is what I told you 
while I was still with you: Everything must be 
fulfilled that is written about me in the Law of 
Moses, the Prophets and the Psalms." (Luke 
24:36-44)



strength is dried up like a potsherd, and my 
tongue sticks to the roof of my mouth; you lay 
me in the dust of death.16Dogs have 
surrounded me; a band of evil men has 
encircled me, they have pierced my hands and
my feet. 17I can count all my bones; people 
stare and gloat over me. 18They divided my 
garments among them and cast lots for my 
clothing. ...22I will declare your name to my 
brothers; in the congregation I will praise you. 
23You who fear the Lord, praise him! All you 
descendants of Jacob, honor him! Revere him,
all you descendants of Israel! ... (Psalm 22)
... 7For I endure scorn for your sake, and 
shame covers my face. 8I am a stranger to my 
brothers, an alien to my own mother's sons; 
9for zeal for your house consumes me, and the
insults of those who insult you fall on me. ... 
19You know how I am scorned, disgraced and 
shamed; and my enemies are before you. 
20Scorn has broken my heart and has left me 
helpless; I looked for sympathy, but there was 
none. 21They put gall in my food and gave me 
vinegar for my thirst. ...(Psalm 69)
1Endow the king with your justice, O God, the 
royal son with your righteousness. 2He will 
judge your people in righteousness, your 
afflicted ones with justice. 3The mountains will 
bring prosperity to the people, the hills the fruit 
of righteousness. 4He will defend the afflicted 
among the people and save the children of the 
needy; he will crush the oppressor. 5He will 
endure as long as the sun, as long as the 
moon, through all generations. 6He will be like 
rain falling on a mown field, like showers 
watering the earth. 7In his days the righteous 
will flourish; prosperity will abound till the moon
is no more. ... 12For he will deliver the needy 
who cry out, the afflicted who have no one to 
help. 13He will take pity on the weak and the 
needy and save the needy from death. 14He 
will rescue them from oppression and violence,
for precious is their blood in his sight. ... 17May 
his name endure forever; may it continue as 
long as the sun. All nations will be blessed 
through him, and they will call him blessed. ...
(Psalm 72)
1The Lord says to my Lord: "Sit at my right 
hand until I make your enemies a footstool for 
your feet." 2The Lord will extend your mighty 
scepter from Zion; you will rule in the midst of 
your enemies. 3Your troops will be willing on 
your day of battle. Arrayed in holy majesty, 
from the womb of the dawn you will receive the
dew of your youth. 4The Lord has sworn and 



will not change his mind: "You are a priest 
forever, in the order of Melchizedek." 5The 
Lord is at your right hand; he will crush kings 
on the day of his wrath. 6He will judge the 
nations, heaping up the dead and crushing the 
rulers of the whole earth. 7He will drink from a 
brook beside the way; therefore he will lift up 
his head. (Psalm 110)
17I will not die but live, and will proclaim what 
the Lord has done. 18The Lord has chastened 
me severely, but he has given me over to 
death. 19Open for me the gates of 
righteousness; I will enter and give thanks to 
the Lord. 20This is the gate of the Lord through 
which the righteous may enter. 21I will give you
thanks, for you answered me; you have 
become my salvation. 22The stone the builders
rejected has become the capstone; 23the Lord 
has done this, and its is marvelous in out eyes.
24This is the day the Lord has made; let us 
rejoice and be glad in it. 25O Lord, save us; O 
Lord, grant us success. 25Blessed is he who 
comes in the name of the Lord. From the 
house of the Lord we bless you. ... (Psalm 118)

Christ would suffer... (Psalm 22; Isaiah 53)
...and rise from the dead on the third day, ...
(Psalm 16:9-11; Isaiah 53:10-11)
... and repentance and forgiveness of sins will 
be preached in his name to all nations ... 
(Isaiah 49:6)

45Then he opened their minds so they could 
understand the Scriptures. 46He told them 
"This is what is written: The Christ will suffer 
and rise from the dead on the third day, 47and 
repentance and forgiveness of sins will be 
preached in his name to all nations, beginning 
at Jerusalem. 48You are witnesses of these 
things. 49I am going to send you what my 
Father has promised; but stay in the city until 
you have been clothed with power from on 
high."
50When he had led them out to the vicinity of 
Bethany, he lifted up his hands and blessed 
them. 51While he was blessing them, he left 
them and was taken up into heaven. 52Then 
they worshiped him and returned to Jerusalem 
with great joy. 53And they stayed continually at 
the temple, praising God. (Luke 24:36-53)

"And afterward, I will pour out my Spirit on all 
people. Your sons and daughters will prophesy,
your old men will dream dreams, your young 
men will see visions. Even on my servants, 
both men and women, I will pour    out my Spirit
in those days. I will show wonders in the 
heavens and on the earth, blood and fire and 
billows of smoke. (Joel 2:28-30)

(Jesus promises the Holy Spirit...) 15Jesus 
said, "If you love me, you will obey what I    
command. 16And I will ask the Father, and he 
will give you another Counselor to be with you 
forever17the Spirit of truth. The world cannot 
accept him, because it neither sees him nor 
knows him. But you know him, for he lives with 
you and will be in you. (John 14:15-17)
(Jesus taken up into heaven...) After his 
suffering, he showed himself to these men and 



gave many convincing proofs that he was alive.
He appeared to them over a period of forty 
days and spoke about the kingdom of God. On 
one occasion, while he was eating with them, 
he gave them, hs gave them this command: 
"Do not leave Jerusalem, but wait for the gift 
my Father promised, which you have heard me
speak about. For John baptized with water, but 
in a few days you will be baptized with the Holy
Spirit." 6So when they met together, they asked
Jesus, "Lord, are you at this time going to 
restore the kingdom to Israel?" 7Jesus said to 
them: "It is not for you to know the times or 
dates the Father has set by his own authority. 
But you will receive power when the Holy Spirit
comes on you; and you will be my witnesses in
Jerusalem, and in all Judea and Samaria, and 
to the ends of the earth." After He said this, He 
was taken up before their very eyes, and a 
cloud hid him from their sight. (Acts 1:3-9)
(The Holy Spirit comes at Pentecost...) 1When 
the Pentecost came, they were all together in 
one place. 2Suddenly a sound like the blowing 
of a violent wind came from heaven and filled 
the whole house where they were sitting. 
3They saw what seemed to be tongues of fire 
that separated and came to rest on each of 
them. 4All of them were filled with Holy Spirit 
and began to speak in other tongues as the 
Spirit enabled them. .... (Acts 2)

End-Time Prophecies
There are many prophecies deal with the end of the world and the new order to be established by our 
Lord God. These prophecies are found in both the Old and the New Testaments which foretold the 
sequence of events to come at the second coming of our Lord Jesus Christ to raise the chosen, to judge 
the world, to destroy the heavens and earth, to create new heavens and a new earth, and to reveal the 
glory of the Holy City, the new Jerusalem. We list a few for your reference.

Signs of the end of the age: In the Gospels according to Matthew and Mark, the Lord Jesus Christ 
answered His disciples' question of the sign of His return and the end of age. In apostle Paul's epistle to 
Timothy, Paul also wrote about Godlessness in the last days.

The day and hour unknown: When Jesus answered the question of His return and the end of age, He also
stressed that no one knows about the day or hour, not even the angels in heaven, nor the Son, but only 
the Father. Other verses in the New Testament also prophesied that the day of the Lord will come like a 
thief in the night.

The great tribulation: In the book of Revelation in the New Testament, the last book of the Bible, apostle 
John recorded the revelation of Jesus Christ. Among the many end-time prophecies recorded in the book 
of Revelation, it is revealed that a great tribulation will come prior to the return of Jesus Christ.

The day of the Lord: Many verses in the New Testament prophesied that Jesus Christ will return at the 
end of the world to raise His chosen people to eternal life. (1 Th. 4:13)



The dead and the living are judged: In the book of Revelation, it also recorded how people will be judged 
according to what they had done. Other verses in the Bible also prophesied about the judgment day. 
(Psalm 22; Romans 14:9, 

New heavens and a new earth: Many verses in the Bible also prophesied the destruction of the existing 
heavens and earth, and the creation of new heavens and a new earth, the home of righteousness. (Psalm
69; 

New Jerusalem: In the book of Revelation and other verses in the Bible, it is prophesied that God will live 
with men in the Holy City, the new Jerusalem.

See also
End-Time Prophecy Samples



Signs of the End of the Age

1. He will confirm a covenant with many for one `seven.` In the middle of the `seven` he will put an end 
to sacrifice and offering. And on a wing of the temple he will set up an abomination that causes 
desolation, until the end that is decreed is poured out on him.(Daniel 9:27)

2. His armed forces will rise up to desecrate the temple fortress and will abolish the daily sacrifice. Then 
they will set up the abomination that causes desolation. (Daniel 11:31)

3. From the time that the daily sacrifice is abolished and the abomination that causes    desolation is set 
up, there will be 1290 days. Blessed is the one who waits for and reaches the end of the 1335 days 
(Daniel 12:11)

4. 37Jesus said, "O Jerusalem, Jerusalem, you who kill the prophets and stone those send to you, how 
often I have longed to gather your children together, as a hen gathers her chicks under her wings, but 
you were not willing. 38Look, your house is left to you desolate. 39For I tell you, you will not see me 
again until you say, `Blessed is he who comes in the name of the Lord.`" (Matthew 23:37-39; Luke 
13:34-35)

5. 4Jesus said: "Watch out that no one deceives you. 5For many will come in my name, claiming, `I am 
the Christ, and will deceive many. 6You will hear of wars and rumors of wars, but see to it that you are
not alarmed. Such things must happened, but the end is still to come. 7Nations will rise against 
nations, and kingdom against kingdom. There will be famines and earthquakes in various places. 8All 
these are the beginning of birth pains. 9Then you will be handed over to be persecuted and put to 
death, and you will be hated by all nations because of me. 10At that time many will turn away from the
faith and will betray and hate each other, 11and many false prophets will appear and deceive many 
people. 12Because of the increase of wickedness, the love of most will grow cold, 13but he who 
stands firm to the end will be saved. 14And this gospel of the kingdom will be preached in the whole 
world as a testimony to all nations, and then the end will come. 15So when you see standing in the 
holy place the abomination that causes desolation, spoken of through the prophet Daniellet the reader
understand16then let those who are in Judea flee to the mountains. 17Let no one on the roof of his 
house go down to take anything out of the house. 18Let no one in the field go back to get his cloak. 
19How dreadful it will be in those days for pregnant women and nursing    mothers! 20Pray that your 
flight will not take place in winter or on the Sabbath. 21For then there will be great tribulation, 
unequaled from the beginning of the world until nowand never to be equaled again. 22If those days 
had not been cut short, no one would survive, but for the sake of the elect those days will be 
shortened. 23At that time if anyone says to you, `Look, there is the Christ! or, `There he is!` do not 
believe it. 24For false Christs and false prophets will appear and perform great signs and miracles to 
deceive even the electif that were possible. 25See I have told you ahead of time.
26So if anyone tells you, `There he is, out in the desert,` do not go out; or `Here he is, in the inner 
rooms,` do not believe it. 27For as lightning that comes from the east is visible even in the west, so 
will be the coming of the Son of Man. 28Wherever there is a carcass, there the vultures will gather.
29Immediately after the tribulation of those days

`the sun will be darkened, and the moon will not give its light; the starts will fall from the sky, and 
the heavenly bodies will be shaken.`
30At that time the sign of the Son of Man will appear in the sky, and all the nations of the earth will 
mourn. They will see the Son of Man coming on clouds of the sky, with power and great glory. 31And 
he will send his angels with a loud trumpet call, and they will gather his elect from the four winds, from
one end of the heavens to the other.
32Now learn this lesson from the fig tree: As soon as its twigs get tender and its leaves comes out, 
you know that summer is near. 33Even so, when you see all these things, you know that it is near, 
right at the door. 34I tell you the truth, this generation will certainly not pass away until all these things 
have happened. 35Heaven and earth will pass away, but my words will never pass away. (Matthew 
24:4-35; Mark 13:5-31)



6. 1But mark this: There will be terrible times in the last days. 2People will be lovers of themselves, 
lovers of money, boastful, proud, abusive, disobedient to their parents, ungrateful, unholy, 3without 
love, unforgiving, slanderous, without self-control, brutal, not lovers of the good, 4treacherous, rash, 
conceited, lovers of pleasure rather than lovers of God5having a form of godliness but denying its 
power. Have nothing to do with them. (2 Timothy 3:1-5)



The Day and Hour Unknown

1. Jesus said, 36"No one knows about that day or hour, not even the angels in heaven, nor the Son, but 
only the Father. 37As it was in the days of Noah, so it will be at the coming of the Son of Man. 38For in
the days before the flood, people were eating and drinking, marrying and giving in marriage, up to the 
day Noah entered the ark; 39and they knew nothing about what would happen until the flood came 
and took them all away. That is how it will be at the coming of the Son of Man. 40Two men will be in 
the field; one will be taken and the other left. 41Two women will be grinding with a hand mill; one will 
be taken and the other left.
42Therefore keep watch, because youo do not know on what day your Lord will come. 43But 
understand this: if the owner of the house had known at what time of night the thief was coming, he 
would have kept watch and would not have let his house be broken into. 44So you also must be 
ready, because the Son of Man will come at an hour when you do not expect him. (Matthew 24:36-44;
Mark 13:32-36)

2. 6So when they met together, they asked Jesus, "Lord, are you at this time going to restore the 
kingdom to Israel?"
7Jesus said to them: "It is not for you to know the times or dates the Father has set by his own 
authority. ..." (Acts 1:6-7)

3. 1Now, brothers, about times and dates we do not need to write to you, 2for you know very well that 
the day of the Lord will come like a thief in the night. 3While people are saying, "Peace and safety," 
destruction will come on them suddenly, as labor pains on a pregnant woman, and they will not 
escape. (1 Thessalonians 5:1-3)

4. But th day of the Lord will come like a thief. The heavens will disappear with a roar; the elements will 
be destroyed by fire, and the earth and everything in it will be laid bare. (2 Peter 3:10)

5. "Behold, I come like a thief! Blessed is he who stays awake and keeps his clothes with him, so that he
may not go naked and be shamefully exposed." (Revelation 16:15)



The Great Tribulation

1. Jesus said, "...15So when you see standing in the holy place the abomination that causes desolation, 
spoken of through the prophet Daniellet the reader understand16then let those who are in Judea flee 
to the mountains. 17Let no one on the roof of his house go down to take anything out of the house. 
18Let no one in the field go back to get his cloak. 19How dreadful it will be in those days for pregnant 
women and nursing    mothers! 20Pray that your flight will not take place in winter or on the Sabbath. 
21For then there will be great tribulation, unequaled from the beginning of the world until nowand 
never to be equaled again. 22If those days had not been cut short, no one would survive, but for the 
sake of the elect those days will be shortened. 23At that time if anyone says to you, `Look, there is the
Christ! or, `There he is!` do not believe it. 24For false Christs and false prophets will appear and 
perform great signs and miracles to deceive even the electif that were possible. 25See I have told you 
ahead of time.
26So if anyone tells you, `There he is, out in the desert,` do not go out; or `Here he is, in the inner 
rooms,` do not believe it. 27For as lightning that comes from the east is visible even in the west, so 
will be the coming of the Son of Man. 28Wherever there is a carcass, there the vultures will gather.
29Immediately after the tribulation of those days

`the sun will be darkened, and the moon will not give its light; the starts will fall from the sky, and 
the heavenly bodies will be shaken.` ... (Matthew 24:15-29' Mark 13:14-27)

2. 21They (i.e., Paul and Barnabas) preached the good news in that city (i.e. Derbe) and won a large 
number of disciples. Then they returned to Lystra, Iconium and Antioch, 22strengthening the disciples 
and encouraging them to remain true to the faith. "We must go through much tribulation to enter the 
kingdom of God," they said. (Acts 14:21-22)

3. 9After this I looked and there before me was a great multitude that no one could count, from every 
nation, tribe, people and language, standing before the throne and in front of the Lamb. They were 
wearing white robes and were holding palm branches in their hands. 10And they cried out in a loud 
voice:
"Salvation belongs to out God, who sits on the throne, and to the Lamb." 11All the angels were 
standing around the throne and around the elders and the four living creatures. They fell down on 
their faces before the throne and worshped God, 12saying:
"Amen! Praise and glory and wisdom and thanks and honor and power and strength be to our God for
ever and ever. Amen!"
13Then one of the elders asked me, "These in white robeswho are they, and where did they come 
from?"
14I answered, "Sir, you know." And he said, "There are they who have come out of the great 
tribulation; they washed their robes and made them white in the blood of the Lamb. (Revelation 7:9-
14)



The Day of the Lord

1. 29Immediately after the tribulation of those days
`the sun will be darkened, and the moon will not give its light; the starts will fall from the sky, and 

the heavenly bodies will be shaken.`
30At that time the sign of the Son of Man will appear in the sky, and all the nations of the earth will 
mourn. They will see the Son of Man coming on clouds of the sky, with power and great glory. 31And 
he will send his angels with a loud trumpet call, and they will gather his elect from the four winds, from
one end of the heavens to the other. (Matthew 24:29-31; Mark 13:24-27

2. 31Jesus said, "When the Son of Man comes in his glory, and all the angels with him, he will sit on his 
throne in heavenly glory. 32All the nations will be gathered before him, and he will separate the people
one from another as a shepherd separates the sheep from the goats. 33He will put the sheep on his 
right and the goats on his left.
34Then the King will say to those on his right, `Come you who are blessed by my Father; take your 
inheritance, the kingdom prepared for you since the creation of the world. 35For I was hungry and you
gave me something to eat, I was thirsty and you gave me something to drink, I was a stranger and 
you invited me in, 36I needed clothes and you clothed me, I was sick and you looked after me, I was 
in prison and you came to visit me.
37Then the righteous will answer him, `Lord, when did we see you hungry and feed you, or thirsty and
give you something to drink? 38When did we see you a stranger and invite you in, or needing clothes 
and clothe you? 39When did we see you sick or in prison and go to visit you?`
40The King will reply, `I tell you the truth, whatever you did for one of the least of these brothers of 
mine, you did for me.`
41Then he will say to those on his left, `Depart from me, you who are cursed, into the eternal fire 
prepared for the devil and his angels. 42For I was hungry and you gave me nothing to eat, I was 
thirsty and you gave me nothing to drink, 43I was a stranger and you did not invite me in, I needed 
clothes and you did not clothe me, I was sick and in prison and you did no look after me.`
44They also will answer, `Lord, when did we see you hungry or thirsty or a stranger or needing clothes
or sick or in prison, and did not help you?`
45He will reply, `I tell you the truth, whatever you did not do for one of the least of these, you did not 
do for me.`
46Then they will go away to eternal punishment, but the righteous to eternal life." (Matthew 25:31-46)

3. 9After He said this, he was taken up before their very eyes, and a cloud hid him from their sight. They 
were looking intently up into the sky as he was taken up before their very eyes, and a cloud hid him 
from their sight.
10They were looking intently up into the sky as he was going, when suddenly tow men dressed in 
white stood beside them. 11"Man of Galilee," they said, "Why do you stand here looking into the sky? 
This same Jesus, who has been taken from you into heaven, will come back in the same way you 
have seen him go into heaven." (Acts 1:9-11)

4. 13Brothers, we do not want you to be ignorant about those who fall asleep, or to grieve like the rest of 
men, who have no hope. 14We believe that Jesus died and rose again and so we believe that God will
bring with Jesus those who have fallen asleep in him. 15According to the Lord's own word, we tell you
that we who are still alive, who are left till the coming of the Lord, will certainly not precede those who 
have fallen asleep. 16For the Lord himself will come down from heaven, with a loud command, with 
the voice of the archangel and with the trumpet call of God, and the dead in Christ will rise first. 
17After that, we who are still alive and are left will be caught up together with them in the clouds to 
meet the Lord in the air. And so we will be with the Lord forever. (1 Thessalonians 4:13-17)

5. But the day of the Lord will come like a thief. The heavens will disappear with a roar; the elements will
be destroyed by fire, and the earth and everything in it will be laid bare. (2 Peter 3:10)



6. "Behold, I come like a thief! Blessed is he who stays awake and keeps his clothes with him, so that he
may not go naked and be shamefully exposed." (Revelation 16:15)



The Dead and the Living are Judged

1. 19Jesus said, "I tell you the truth, the Son can do nothing by himself; he can do only what he sees his 
Father doing, because whatever the Father does the Son also does. 20For the Father loves the Son 
and shows him all he does. Yes, to your amazement he will show him even greater things than these. 
21For just as the Father raises the dead and gives life to whom he is pleased to give it. 22Moreover, 
the Father judges no one, but has entrusted all judgment to the Son, 23that all may honor the Son just
as they honor the Father. He who does not honor the Son does not honor the Father, who sent him.
24I tell you the truth, whoever hears my word and believes him who sent me has eternal life and will 
not be condemned; he has crossed over from death to life. 25I tell you the truth, a time is coming and 
has now come when the dead will hear the voice of the Son of God and those who hear will live. 
26For as the Father has life in himself, so he has granted the Son to have life in himself. 27And he has
given him authority to judge because he is the Son of Man.
28Do not be amazed at this, for a time is coming when all who are in their graves will hear his voice 
29and come outthose who have done good will rise to live, and those who have done evil will rise to 
be condemned. 30By myself I can do nothing; I judge only as I hear, and my judgment is just, for I 
seek not to please myself but him who sent me. (John 5:19-30)

2. (Paul preached in Athens...) 29Therefore since we are God's offspring, we should not think that the 
divine being is like gold or silver or stonean image made by man's design and skill. 30In the past God 
overlooked such ignorance, but now he commands all people everywhere to repent. 31For he has set 
a day when he will judge the world with justice by the man he has appointed. He has given proof of 
this to all men by raising him from the dead." (Acts 17:29-31)

3. 7For none of us lives to himself alone and none of us dies to himself alone. 8If we live, we live to the 
Lord; and if we die, we die to the Lord. So, whether we live or die, we belong to the Lord.
9For this very reason, Christ died and returned to life so that he might be the Lord of both the dead 
and the living. 10You, then, why do you judge your brother? or why do you look down on your brother?
For we will all stand before God's judgment seat. 11It is written:
"`As surely as I live,` says the Lord, `every knee will bow before me; every tongue will confess to 
God.`"
12So then, each of us will give an account of himself to God. (Romans 14:7-12)

4. 6Therefore we are always confident and know that as long as we are at home in the body we are 
away from the Lord. 7We live by faith, not by sight. 8We are confident, I say, and would prefer to be 
away from the body and at home with the Lord. 9So we make it our goal to please him, whether we 
are at home in the body or away from it. 10For we must all appear before the judgment seat of Christ, 
that each one may receive what is due him for the things done while in the body, whether good or 
bad. (2 Corinthians 5:6-10)

5. 1In the presence of God and of Christ Jesus, who will judge the living and the dead, and in view of his
appearing and his kingdom, I give you this charge: 2Preach the Word; be prepared in season and out 
of season; correct, rebuke and encouragewith great patience and careful instruction. (2 Timothy 4:1-
2)

6. 1Therefore, since Christ suffered in his body, arm yourselves also with the same attitude, because he 
who has suffered in his body is done with sin. 2As a result, he does not live the rest of his earthly life 
for evil human desires, but rather for the will of God. 3For you have spent enough time in the past 
doing what pagans choose to doliving in debauchery, lust, drunkenness, orgies, carousing and 
detestable idolatry. 4They think it strange that you do not plunge with them into the same flood of 
dissipation, and they heap abuse on you. 5But they will have to give account to him who is ready to 
judge the living and the dead. 6For this is the reason the gospel was preached even to those who are 
now dead, so that they might be judged according to men in regard to the body, but live according to 
God in regard to the spirit. (1 Peter 4:1-6)



7. 11Then I saw a great white throne and him who was seated on it. Earth and sky fled from his 
presence, and there was no place for them. 12And I saw the dead, great and small, standing before 
the throne, and books were opened. Another book was opened, which is the book of life. The dead 
were judged according to what they had done as recorded in the books. 13The sea gave up the dead 
that were in it, and death and Hades gave up the dead that were in them, and each person was 
judged according to what he had done. 14Then death and Hades were thrown into the lake of fire. The
lake of fire is the second death. 15If anyone's name was not found written in the book of life, he was 
thrown into the lake of fire. (Revelation 20:11-15)



New Heavens and a New Earth
1. 17Behold, I will create new heavens and a new earth. The former things will not be remembered, nor 

will they come to mind. 18But be glad and rejoice forever in what I will create, for I will create 
Jerusalem to be a delight and its people a joy. 19I will rejoice over Jerusalem and take delight in my 
people; the sound of weeping and of crying will be heard in it no more. 20"Never again will there be in 
it an infant who lives but a few days, or an old man who does not live out his years; he who dies at a 
hundred will be thought a mere youth; he who fails to reach a hundred will be considered accursed. 
21They will build houses and dwell in them; they will plant vineyards and eat their fruit. 22No longer 
will they build houses and others live in them, or plant and others eat. For as the days of a tree, so will
be the days of my people; my chosen ones will long enjoy the works of their hands. 23They will not toil
in vain or bear children doomed to misfortune; for they will be a people blessed by the Lord, they and 
their descendants with them. 24Before they call I will answer; while they are still speaking I will hear. 
25The wolf and the lamb will feed together, and the lion will eat straw like the ox, but dust will be the 
serpent's food. They will neither harm nor destroy on all my holy mountain," Says the Lord. (Isaiah 
65:17-25)

2. 10But the day of the Lord will come like a thief. The heavens will disappear with a roar; the elements 
will be destroyed by fire, and the earth and everything in it will be laid bare.
11Since everything will be destroyed in this way, what kind of people ought you to be? You ought to 
live holy and godly lives 12as you look forward to the day of God and speed its coming. That day will 
bring about the destruction of the heavens by fire, and the elements will melt in the heat. 13But in 
keeping with his promise we are looking forward to a new heaven and a new earth, the home of 
righteousness. (2 Peter 3:10-13)

3. Then I saw a new heaven and a new earth, for the first heaven and the first earth had passed away, 
and there was no longer any sea. (Revelation 21:1)



New Jerusalem
1. 17Behold, I will create new heavens and a new earth. The former things will not be remembered, nor 

will they come to mind. 18But be glad and rejoice forever in what I will create, for I will create 
Jerusalem to be a delight and its people a joy. 19I will rejoice over Jerusalem and take delight in my 
people; the sound of weeping and of crying will be heard in it no more. (Isaiah 65:17-19)

2. 1The I saw a new heaven and a new earth, for the first heaven and first earth had passed away, and 
there was no longer any sea. 2I saw the Holy City, the new Jerusalem, coming down out of heaven 
from God, prepared as a bride beautifully dressed for her husband. 3And I heard a loud voice from the
throne saying, "Now the dwelling of God is with men, and he will live with them. They will be his 
people, and God himself will be with them and be their God. 4He will wipe away every tear from their 
eyes. There will be no more death or mourning or crying or pain, for the old order of things has 
passed away. ... 
9One of the seven angels who had the seven bowls full of the seven last plagues came and said to 
me, "Come, I will show you the bride, the wife of the Lamb." 10And he carried me away in the Spirit to 
a mountain great and high, and showed me the Holy City, Jerusalem, coming down out of heaven 
from God. 11It shone with the glory of God, and its brilliance was like that of a very precious jewel, like
a jasper, clear as crystal. 12It had a great, high wall with twelve gates, and with twelve angels at the 
gates. On the gates were written the names of the twelve tribes of Israel. 13There were three gates on
the east, three on the north, three on the south and three on the west. 14The wall of the city had 
twelve foundations, and on them were the names of the twelve apostles of the Lamb. ...
22I did not see a temple in the city, because the Lord God Almighty and the Lamb are its temple. 
23The city does not need the sun or the moon to shine on it, for the glory of God gives it light, and the 
Lamb is its lamp. 24The nations will walk by its light, and the kings of the earth will bring their splendor
into it.. 25On no day will its gates ever be shut, for there will be no night there. 26The glory and honor 
of the nations will be brought into it. 27Nothing impure will ever enter it, nor will anyone who does what
is shameful or deceitful, but only those whose names are written in the Lamb's book of life. 
(Revelation 21)



Parables Told by Jesus Christ in the Gospels
During the ministry of the Lord Jesus Christ, He told many short tales that uses earthly things as analogy 
to convey spiritual meaning to the hearer. Most of these parables dealt with the essential preaching of 
Jesus Christ, the Kingdom of God (No. 2-8, 13-17, 19-22)    the love of God (No. 9-11), and loving each 
other as Jesus Christ first loved us (1 John 4:19) (No. 13, 18, 23). While explaining the parable of the 
sower, Jesus said to His disciples, "The knowledge of the secrets of the kingdom of God has been given 
to you, but to others I speak in    parables, so that, "`though seeing, they may not see; though hearing, 
they may not understand.`" Therefore, to understand a parable, we must study under what circumstances 
a parable was told and how the Lord Jesus explained it. Also one must not ignore important features in a 
parable, yet not make all details mean something.

1. The sower (Matthew 13:3-9; 18-23; Mark 4:3-8; 14-20; Luke 8:5-8, 11-15)
2. The growing seed (Mark 4:26-29)
3. The weeds (Matthew 13:24-30; 37-43)
4. The mustard seed (Matthew 13:31-32; Mark 4:30-32; Luke 13:18-19)
5. The yeast (Matthew 13:33; Luke 13:20-21)
6. The hidden treasure (Matthew 13:44)
7. The fine pearls (Matthew 13:45-46)
8. The net (Matthew 13:47-48; 49-50)
9. The lost sheep (Matthew 18:12-13; 10-11,14; Luke 15:4-7)
10. The lost coin (Luke 15:8-10)
11. The lost son (Luke 15:11-32)
12. The shrewd manager (Luke 16:1-14)
13. The unmerciful servant (Matthew 18:21-35)
14. The workers in the vineyard (Matthew 20:1-16)
15. The two sons (Matthew 21:28-31; 31-32)
16. The tenants (Matthew 21:33-40;42-44; Mark 12:1-11; Luke 20:9-16)
17. The wedding banquet (Matthew 22:1-14; Luke 14:16-24)
18. The good Samaritan (Luke 10:25-36)
19. The rich fool (Luke 12:16-20, 21-34)
20. The loyal servant (Luke 12:35-48)
21. The ten virgins (Matthew 25:1-12; 13)
22. The talents (Matthew 25:14-28; 29-30)
23. The sheep and the goats (Matthew 25:31-46)
24. The fig tree in a vineyard (Luke 13:6-9)
25. The narrow door (Luke 13:24-30)
26. The persistent widow (Luke 18:2-8)
27. The Pharisee and the tax collector (Luke 18:10-14)
28. The ten minas (Luke 19:12-27)

See also
Jesus' Parable Samples



The Parables of the Sower
(Matthew 13:3-9; 18-23; Mark 4:3-8; 14-20; Luke 8:5-8, 11-15)

3Jesus said, "A farmer went out to sow his seed. 4As he was scattering the seed, some fell along the 
path, and the birds came and ate it up. 5Some fell on rocky places, where it did not have much soil. It 
sprang up quickly, because the soil was shallow. 6But when the sun came up, the plants were scorched, 
and they withered because they had no root. 7Other seed fell among thorns, which grew up and choked 
the plants. 8Still other seed fell on good soil, where it produced a cropa hundred, sixty or thirty times what 
was    sown. 9He who has ears, let him hear." (Matthew 13:3-9)

18Jesus said, "Listen then to what the parable of the sower means: 19When anyone hears the message 
about the kingdom and does not understand it, the evil one comes and snatches away what was sown in 
his heart. This is the seed sown along the path. 20The one who received the seed that fell on rocky places
is the man who hears the word and at once receives it with joy. 21But since he has no root, he lasts only a
short time. When trouble or persecution comes because of the word, he quickly falls away. 22The one 
who received the seed that fell among the thorns is the man who hears the word, but the worries of this 
life and the deceitfulness of wealth choke it, making it unfruitful. 23But the one received the seed that fell 
on good soil is the man who hears the word and understands it. He produces a crop, yielding a hundred, 
sixty or thirty times what was sown." (Matthew 13:18-23)

Explanation:
The parable was recorded in verse 3 to 9, and the explanation Jesus gave to his disciples was recorded 
in verse 18-23. As depicted in the drawing, there is a direct correspondence between the characters in the
parable and the ones in its spiritual meaning. The relationships among the characters also correspond 
with each other.



The Parables of the Lost Sheep
(Matthew 18:12-13; 10-11,14; Luke 15:4-7)

10Jesus said, "See that you do not look down on one of these little ones. For I tell you that their angles in 
heaven always see the face of my Father in heaven. 11The Son of Man came to save what was lost.
12What do you think? If a man owns a hundred sheep, and one of them wanders away, will he not leave 
the ninety-nine on the hills and go to look for the one that wandered off? 13And if he finds it, I tell you the 
truth, he is happier about that one sheep than about the ninety-nine that did not wander off. 14In the same
way, your Father in heaven is not willing that any of these little ones should be lost." (Matthew 18:10-14)

Explanation:
The body of the parableis is recorded in verse 12 and 13, and it can be understood with verse 10, 11 and 
14. This parable is also recorded in Luke 15:4-7 under different circumstances, but its spiritual meaning is
the same, that our Lord does not let any children to be lost (or any sinner not turn back in repentence). 
This parable shows the love of our Heavenly Father towards us, the sinners and the lost sheep of the 
world.



The Parables of the Unmerciful Servant
(Matthew 18:21-35)

21Then Peter came to Jesus and asked, "Lord, how many times shall I forgive my brothers when he sins 
against me? Up to seven times?"
22Jesus answered, "I tell you, not seven times, but seventy-seven times.
23Therefore, the kingdom of heaven is like a king who wanted to settle accounts with his servants. 24As 
he began the    settlement, a man who owed him ten thousand talents was brought to him. 25Since he was
not able to pay, the master ordered that he and his wife and his children and all that he had be sold to 
repay the debt.
26The servent fell on his knees before him. `Be patient with me.` he begged, `and I will pay back 
everything.` 27The servant's master took pity on him, canceled the debt and let him go.
28But when that servant went out, he found one of his fellow servants who owed him a hundred denarii. 
He grabbed him and began to choke him. `Pay back what you owe me!` He demanded.
29His fellow servant fell to his knees and begged him, `Be patient with me, and I will pay you back.`
30But he refused. Instead, he went off and had the man thrown into prison until he could pay the debt. 
31When the other servants saw what had happened, they were greatly distressed and went and told their 
master everything that had happened.
32Then the master called the servant in. `You wicked servant,` he said, `I canceled all that debt of yours 
because you begged me to. 33Shouldn't you have had mercy on your fellow servant just as I had no you?`
34In anger his master turned him over to the jailers to be tortured, until he should pay back all he owed.
35This is how my heavenly Father will treat each of you unless you forgive your brother from your heart." 
(Matthew 18:21-35)

Explanation:
This parable shows how we should forgive the sins of others as God had forgave our sins, and love 
others as God had loved us. It can also be understood with a verse in the Lord's prayer (Matthew 6:9-
13)"Forgive us our debts, as we also have forgiven our debtors". The drawing depicts the characters as 
well as their relationships in the parable and in its spiritual meaning.



The Parables of the Good Samaritan
(Luke 10:25-37)

25On one occasion and expert in the law stood up to test Jesus. "Teacher," he asked, "What must I do to 
inherit eternal life?"
26"What is written in the Law?" he replied. "How do you read it?"
27He answered: "`Love the Lord your God with all your heart and with all your soul and with all your 
strength and with all your mind`; and `Love you neighbor as yourself.`"
28"You answered correctly," Jesus replied. "Do this and you will live."
29But he wanted to justify himself, so he asked Jesus, "And who is my neighbor?"
30In reply Jesus answered: "A man was going down from Jerusalem to Jericho, when hs fell into the 
hands of robbers. They stripped him of his clothes, beat him and went away, leaving him half dead. 31A 
priest happened to be going down the same road, and when he saw the man, he passed by on the other 
side. 32So too, a Levite, when he came to the place and saw him, passed by on the other side. 33But a 
Samaritan, as he traveled, came where the man was; and when he saw him, he took pity on him. 34He 
went to him and bandaged his wounds, pouring on oil and wine. Then he put the man on his own donkey, 
took him to an inn and took care of the him. 35The next day he took out two silver coins and gave them to 
the innkeeper. `Look after him,` he said, `and when I return, I will reimburse you for any extra expense 
you may have.`
36Which of these three do you think was a neighbor to the man who fell into the hands of robbers?"
37The expert in the law replied, "The one who had mercy on him."
Jesus told him, "Go and do likewise." (Luke 10:25-37)

Explanation:
The parable was recorded in verse 30 to 36. To understand this parable, read the circumstance recorded 
in verse 25 to 29. The main character in the parable is the good Samaritan, from Samariaa nation hostile 
to the Jews, helped a stranger in need. Similarly, we should love others as ourselves without considering 
their nationality, race, wealth, etc. We should follow the new command Jesus gave us, "Love each other 
as I have loved you. Greater love has no one than this, that he lay down his life for his friends" (John 
15:12-13).



The Parables of the Rich Fool
(Luke 12:16-20, 21-34)

13Someone in the crowd said to him, "Teacher, tell my brother to divide the inheritance with me."
14Jesus replied, "Man, who appointed me a judge or an arbiter between you?" 15Then he said to them, 
"Watch out! Be on your guard against all kinds of greed; a man's life does not consist in the abundance of 
his possessions."
16And he told them this parable: "The ground of a certain rich man produced a good crop. 17He thought to
himself, `What shall I do? I have no place to store my crops.`
18Then he said, `This is what I'll do. I will tear down my barns and build bigger ones, and there I will store 
all my grain and my goods. 19And I'll say to myself, "You have plenty of good things laid up for many 
years. Take life easy; eat, drink and be merry."`
20But God said to him, `You fool! This very night your life will be demanded from you. Then who will get 
what you have prepared for yourself?`
21This is how it will be with anyone who stores up things for himself but is not rich toward God."
22Then Jesus said to his disciples: "Therefore I tell you, do no worry about your life, what you will eat; or 
about your body, what you will wear. 23Life is more than food, and body more than clothes. 24Consider the
ravens: They do not sow or reap, they have no storeroom or barn; yet God feeds them. And how much 
more valuable you are than birds! 25Who of you by worrying can add a single hour to his life? 26Since you
cannot do this very little thing, why do you worry about the rest?
27Consider how the lilies grow. They do not labor or spin. Yet I tell you, not even Solomon in all his 
splendor was dressed like one of these. 28If that is how God clothes the grass of the field, which is here 
today, and tomorrow is thrown into the fire, how much more will he clothe you. O you of little faith! 29And 
do not set your heart on what you will eat or drink; do not worry about it. 30For the pagan world runs after 
all such things, and your Father knows that you need them. 31But seek his kingdom, and these things will 
be given to you as well.
32Do not be afraid, little flock, for your Father has been pleased to give you the kingdom. 33Sell your 
possessions and give to the poor. Provide purses for yourselves that will not wear out, a treasure in 
heaven that will not be exhausted, where no thief comes near and no moth destroys. 34For where your 
treasure is, there your heart will be also. (Luke 12:13-34)

Explanation:
The body of the parable is from verse 16 to 20, and the other verses record the circumstances and the 
explanation Jesus gave to His disciples. The spiritual meaning is that we should not pursue after the 
worldly riches, rather we should sell our possessions and give to the poor in order to store up treasure in 
the Kingdom of heaven.



The Parables of the Ten Virgins
(Matthew 25:1-12; 13)

1Jesus said, "At that time the kingdom of heaven will be like ten virgins who took their lamps and went out
to meet the bridegroom. 2Five of them were foolish and five were wise. 3The foolish ones took their lamps
but did not take any oil with them. 4The wise, however, took oil in jars along with their lamps. 5The 
bridegroom was a long time in coming, and they all became drowsy and fell asleep.
6At midnight the cry rang out: `Here's the bridegroom! Come out to meet him!`
7Then all the virgins woke up and trimmed their lamps. 8The foolish ones said to the wise, `Give us some 
of your oil; our lamps are going out.`
9"`No,` they replied,    `there may not be enough for both us and you. Instead, go to those who sell oil and 
buy some for yourselves.`
10But while they were on their way to buy the oil, the bridegroom arrived. The virgins who were ready 
went in with him to the wedding banquet. And the door was shut.
11Later the others also came. `Sir! Sir! they said. `Open the door for us!`
12But he replied, `I tell you the truth, I don't know you.`
13Therefore keep watch, because you do not know the day or the hour. (Matthew 25:1-13)

Explanation:
This parable was part of Jesus' answer to his disciples' question about the signs of His return and the end
of age. This parable followed Jesus' revelation that since the end of age will come on a unknown day and 
hour, the servants of the Lord (the believers) should keep watch and remain faithful. It deals with the 
kingdom of heaven and how one should be constantly prepared to welcome its arrival, just as did the five 
wise virgins (i.e., bridesmaids, representing the believers who have been purified from their sins through 
the blood of Jesus Christ) that are allowed into the wedding banquet. The wedding banquet can be 
understood with a verse in the book of Revelation, "blessed are those who are invited to the wedding 
supper of the Lamb!" (Revelation 19:9). On the day of the return of Jesus Christ, the elect will be raised to
eternal life in the kingdom of God, which is symbolically revealed as the wedding banquet of the Lamb 
(the Lord Jesus Christ) with the bride (i.e. the true churchEphesians 5:32), and those who are invited (the 
virgins) are the people raised to eternal life.



The Parables of the Talents
(Matthew 25:14-28; 29-30)

14Jesus said, "Again, it will be like a man going on a journey, who called his servants and entrusted his 
property to them. 15To one he gave five talents of money, to another two talents, and to another one 
talent, each according to his ability. Then he went on his journey. 16The man who had received the five 
talents went at once and put his money to work and gained five more. 17So also, the one with the two 
talents gained two more. 18But the man who had received the one talent went off, dug a hole in the 
ground and hid his    master's money.
19After a long time the master of those servants returned and settled accounts with them. 20The man who
had received the five talents brought the other five. `Master,` he said, `you entrusted me with five talents. 
See, I have gained five more.`
21His master replied, `Well done, good and faithful servant! You have been faithful with a few things; I will 
put you in charge of many things. Come and share your master's happiness!`
22The man with the two talents also came. `Master,` he said, `you entrusted me with two talents; see, I 
have gained two more.`
23His master replied, `Well done, good and faithful servant! You have been faithful with a few things; I will 
put you in charge of many things. Come and share your master's happiness!`
24Then the man who had received the one talent came. `Master,` he said, `I knew that you are a hard 
man, harvesting where you have not sown and gathering where you have not scattered seed. 25So I was 
afraid and went out and his your talent in the ground. See, here is what belongs to you.`
26His master replied, `You wicked, lazy servant! So you knew that I harvest where I have not sown and 
gather where I have not scattered seed? 27Well then, you should have put my money on deposit with the 
bankers, so that when I returned I would have received it back with interest.`
28`Take the talent from him and give it to the one who has the ten talents. 29For everyone who has will be 
given more, and he will have an abundance. Whoever does not have, even what he has will be taken 
from him. 30And throw that worthless servant outside, into the darkness, where there will be weeping and 
gnashing of teeth.` (Matthew 25:14-30)

Explanation:
This parable follows the parable of the ten virgins in the answer Jesus gave to disciples about the signs of
the end of ages. It teaches us that as believers, even we don't know the date and hour of the end of age, 
we should keep watch and be prepared for the return of our Lord Jesus Christ. The believers with more 
talentsspiritual gifts (e.g., message of wisdom, faith, healing, and prophecy) should offer more service to 
the church (see 1 Corinthians 12:1-11) and their reward will be great.



The Parables of the Sheep and the Goats
(Matthew 25:31-46)

31Jesus said, "When the Son of Man comes in his glory, and all the angels with him, he will sit on his 
throne in heavenly glory. 32All the nations will be gathered before him, and he will separate the people 
one from another as a shepherd separates the sheep from the goats. 33He will put the sheep on his right 
and the goats on his left.
34Then the King will say to those on his right, `Come you who are blessed by my Father; take your 
inheritance, the kingdom prepared for you since the creation of the world. 35For I was hungry and you 
gave me something to eat, I was thirsty and you gave me something to drink, I was a stranger and you 
invited me in, 36I needed clothes and you clothed me, I was sick and you looked after me, I was in prison 
and you came to visit me.
37Then the righteous will answer him, `Lord, when did we see you hungry and feed you, or thirsty and 
give you something to drink? 38When did we see you a stranger and invite you in, or needing clothes and 
clothe you? 39When did we see you sick or in prison and go to visit you?`
40The King will reply, `I tell you the truth, whatever you did for one of the least of these brothers of mine, 
you did for me.`
41Then he will say to those on his left, `Depart from me, you who are cursed, into the eternal fire prepared
for the devil and his angels. 42For I was hungry and you gave me nothing to eat, I was thirsty and you 
gave me nothing to drink, 43I was a stranger and you did not invite me in, I needed clothes and you did 
not clothe me, I was sick and in prison and you did no look after me.`
44They also will answer, `Lord, when did we see you hungry or thirsty or a stranger or needing clothes or 
sick or in prison, and did not help you?`
45He will reply, `I tell you the truth, whatever you did not do for one of the least of these, you did not do for
me.`
46Then they will go away to eternal punishment, but the righteous to eternal life." (Matthew 25:31-46)

Explanation:
This parable follows the parable of the talents in the answer Jesus gave to disciples about the signs of the
end of ages. The spiritual meaning deals with the final judgment of the living and the dead, and should be 
understood as such. The sheep are ones to be allowed into the kingdom of heaven, and the goats are the
ones to be rejected.



The Parables of the Narrow Door
(Luke 13:22-30)

22Then Jesus went through the towns and villages, teaching as he made his way to Jerusalem. 
23Someone asked him, "Lord, are only a few people going to be saved?"
He said to them, 24"Make every effort to enter through the narrow door, because many, I tell you, will try to
enter and will not be able to. 25Once the owner of the house gets up and closes the door, you will stand 
outside knocking and pleading, `Sir, open the door for us.`
But he will answer, `I don't know you or where you come from.`
26Then you will say, `We ate and drank with you, and taught in our streets.`
27But he will reply, `I don't know you or where you come from. Away from me, all you evildoers!`
28There will be weeping there, and gnashing of teeth, when you see Abraham, Isaac and Jacob and all 
the prophets in the kingdom of God, but you yourselves thrown out. 29People will come from east and 
west and north and south, and will take their places at the feast in the kingdom of God. 30Indeed there are
those who are last who will be first, and first who will be last." (Luke 13:22-30)

Explanation:
This parable deals with the kingdom of God (i.e., kingdom of heaven). This parable should be understood 
with verses in the Gospel according to Matthew 7:13-14:
"Jesus said, `Enter through the narrow gate. For wide is the gate and broad is the road that leads to 
destruction, and many enter through it. But small is the gate and narrow the road that leads to life, and 
only a few finds it`".




